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OBJECTIVES OF HDB BIM GUIDE 
 

The objective of this Guide is to assist Consultants and Contractors to develop BIM model(s) 

collaboratively for new public housing developments. It sets out the general requirements for the 

preparation of a BIM Execution Plan and the guidelines in developing the BIM models for sharing 

and collaboration amongst the different team members of a HDB project throughout the project life 

cycle.    

 

This Guide serves as a general reference guide for typical new public housing developments and 

hence, may not cover all scenarios that may arise. This Guide also does not cover engineering 

calculations and design analyses. Users are encouraged to adapt the guidelines and steps accordingly 

to suit their needs. 

 

This Guide is developed using the Autodesk Revit (“Revit”) software. Users are expected to have a 

basic knowledge of the software. It also does not cover the explanation of Revit terms used. Please 

refer to support documentation for Revit software for the definitions of Revit terms used. 

 

There are two parts to the Guide: 

Part I: General BIM Requirements & Modelling Guidelines 

 This part defines the minimum requirements for BIM implementation and modelling, 

including the Core Information required in models to be observed for all new public 

housing developments. There may be additional requirements on a case-by-case 

basis, depending on the complexity and specific requirements of the development. 

 

Part II: Modelling Step-by-Step 

  This part outlines the steps and procedures for creating the architectural, structural 

and MEP models for new public housing developments. 

 

It is recommended to read this Guide together with the Singapore BIM Guide and BCA’s BIM e-

Submission Guidelines for additional information and other agencies’ requirements. 
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1.0 BIM EXECUTION PLAN 

1.1 Introduction 
The BIM Execution Plan (BEP) outlines the plan and processes in which BIM will be 

implemented throughout the project lifecycle.  It will form the basis for the Project Team to 

achieve the BIM goals set for the project. 

 

The BEP shall be updated and implemented by the Project Team in accordance with HDB's 

BIM Requirements and using the HDB BEP Template as provided. The BEP shall be submitted 

to HDB for review and acceptance after the multi-disciplinary consultancy team is appointed 

according to the timeframe stated in HDB’s BIM Requirements. 

 

The BEP shall contain but not limited to, the following contents: 

 Project information;  

 BIM goals for project; 

 BIM use cases for each stage of the project; 

 BIM deliverables for each BIM use case; 

 Project members’ roles, responsibilities and competency;  

 BIM process and strategy;  

 BIM exchange protocol and submittal format;  

 BIM data requirement;  

 Collaboration procedures and method to handle shared Models;  

 Quality control;  

 Technology infrastructure & software; and 

 Others 

 

Reference may be made to the ‘Singapore BIM Guide Version 2’ and the ‘BIM Essential Guide 

for BIM Execution Plan’ templates for guidance on the preparation of the BEP. 

 

 
 HDB BEP Template 

file:///C:/Work/CCIT/GPEs/HDB/HDB_Review_Guide/1_Working/HDB_BEP_Template.xlsx
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1.2 BIM Objectives, Responsibilities and Deliverables 
 As part of the BEP, the BIM Manager shall specify the roles and responsibilities of the project 

members when using BIM at different stages of a project as set out in Section D of the BEP 

‘Project Use Cases and Deliverables’.  

 

  
HDB BEP Template - Section D: Project Use Cases and Deliverables  
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2.0 BIM STAGES & DELIVERABLES 

2.1 Stages and Deliverables 
 The project milestones and the BIM deliverables at each stage will be provided by HDB to 

the Consultants separately.  

  

 

3.0 CORE INFORMATION & MODELLING 

3.1 Core Information for BIM Objects 
This section defines the list of BIM objects and their core non-geometric attributes that the 

Consultants shall model for design coordination and possible use by contractors during 

construction stage.  

 

Objectives: 

 To standardise the elements used within the software for creating the objects  for 

consistency and clarity in communication between project members;  

 

 To streamline the workflow and reduce the drawings to be produced by the Consultants 

for use by the Contractor; and 

 

 To define the Core Information for architectural, structural and M&E objects that should 

be provided by the Consultants for use by the Contractor for construction planning and 

execution and development of the construction model and improve information flow 

between the Consultants and Contractor. 

 

Please refer to the HDB BEP Template together with the Core Information for list of BIM 

objects, Revit terms and the core information that require input by the Consultants. 

 

Note: 

Samples of Revit templates and families will be provided as reference for Consultants to 

provide the Core Information in their models. 

 

However, HDB shall not be responsible for any costs, expenses, liabilities or damages which 

may result from the use of these templates and families. 

  

You may refer to Part II: Section 5.2 of this Guide for the steps to transfer the core 

information parameters from the Core Information sample templates to your own 

company’s customised templates. 
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4.0 BIM COORDINATION 

4.1 Quality Assurance 
 To ensure that the discipline specific model is accurate and correct according to the 

modelling guidelines set out in the HDB BIM requirements, this Guide and the BEP should be 

strictly adhered to.  

  

Quality checks should be carried out at two levels:  

a. Each project member should be responsible for performing quality control checks of their 

design, dataset and model properties before submitting their deliverables and sharing 

their models with the other disciplines.  

b. Inter-disciplinary models should be checked against each other for clashes and these 

should be resolved or corrected prior to construction to reduce reworks and variations on 

site. 

 

Please refer to the ‘Singapore BIM Guide Version 2’ on Quality Assurance and Quality 

Control and the Modelling Guidelines to ensure appropriate checks on the model 

information are done and data accuracy is maintained.  Clash detection outlined in the 

matrix under Part I: Section 4.3 above should also be performed as one of the quality checks. 

 

The BIM Coordinators, BIM Manager and the Consultants are required to declare in the 

Quality Assurance Checklist provided that the BIM models created comply with the 

modelling standards set out in the HDB BIM Requirements, this Guide and the BEP. 

 

 

4.2 Sharing of Models 
 

a. Consultants should create their respective discipline models according to the agreed 

deliverables and the elements required for each deliverable as stated under Sections D 

and F of the HDB BEP Template. 

 

In addition, for the purpose of coordination, Consultants should also incorporate the 

modelling guidelines as stipulated in Section G of the HDB BEP Template. 

 

b. Project members should share their models with one another at frequencies agreed 

between the members and stated in the BEP for reference when they are developing the 

model for their own discipline.  

 

At certain milestones, models from different disciplines should be subjected to various 

coordination processes to allow the project team to resolve potential conflicts upfront 

and avoid costly abortive works and delays at the construction stage. 
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c. The project team should agree on the frequency of sharing the BIM models and record 

the agreement in Section E of the BEP. The BIM models should at least be shared 

according to the milestones provided by HDB separately. 

 

d. All project members should use a common project base file and use this to model their 

respective portion. 

 

e. Proper management of project team and workflow is required for successful BIM 

coordination. 

Note:  

Coordination is not done automatically by the computer. 

 

f. The BIM model to be shared should be checked, 

approved and validated by the BIM coordinators 

for the respective disciplines to be “fit for 

coordination” prior to sharing. It is recommended 

to use a common (software) platform to reduce 

possibilities of data loss or errors when sharing 

different models. 

 

g. After the first set of models is received, they 

should be checked with the Project Review tool 

to ensure that they are placed in a common 

location and orientation.  
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4.3 Coordination Process 
 

a. The following items should be discussed and decided at the BIM Kick-Off Meeting prior 

to the commencement of any modelling. The decisions made should be recorded in 

Section E of the BEP. 

 Schedule; 

 File naming convention; 

 Location, orientation and reference points; 

 File transfer methods; 

 File formats; and 

 BIM tools and versions 

 

b. It is recommended to export part models as individual files to facilitate inter-disciplinary 

coordination.  

 

Example: 

 Each MEP trade as an individual file. 

 Each storey as an individual file.  

 A storey can be further divided into zones and exported as an individual file for big 

projects. 

 

Issues could be identified quickly as false issues are minimized. E.g. If a clash checking is 

done between the electrical system and the ceiling, there will be many false issues 

between ceiling and flush lights.  These clashes can be ignored by not performing the 

clash between the lights and the ceiling. 

 

c. Decide on the colour codes for each trade and assign them accordingly when they are 

combined together in a Project Review Tool. Colour coding allows users to identify issues 

visually. 

 

Note:  

Avoid colours that were used for highlighting or error by the Project Review Tool. 

 

Example: 

Architectural = Dark Green 

Structural = Dark Brown 

Fire Protection = Dark Red 

Plumbing = Light Green 

Sewerage = Yellow 

 

d. Perform the coordination check before every coordination meeting; identify clashes, 

quality issues and geometry inconsistency. Record it for discussion in the meeting. This 

step is necessary for an effective design coordination meeting.  
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It is important to recognise that not all conflicts detected are problems. Certain conflicts 

may have been intentional during the modelling process for the sake of simplifying the 

modelling process. Proper search sets and clash rules should be set up before running the 

respective coordination processes, to:  

 Reduce time and resources spent on detecting false positives.  

 Hide elements that are unnecessary in the coordination process, for example, known 

issues that are to be resolved in later project stages; elements that do not impact the 

cost when changed on site, etc.  

 Group particular elements for a specific type of coordination process, such as forming 

groups between a ceiling search set and an MEP model only during a clash analysis  

 

Clash results need to be judged in the context of the elements being analysed, and the 

type of clash detection software being used. For example, one issue that may occur are 

duplicate instances of the same clash – for example, a pipe hitting beam could represent 

20 clashes when in reality it is only one single issue.   
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e. Focus on highlighting and resolving coordination issues at coordination meetings, 

including identifying the project member responsible to follow up. 

 

Note:  

It is recommended to record these issues and the discipline assigned to follow up as a 

report. 

 

 

 
Sample views of clash reports generated from clash detection software 

 

f. Clash detection reports for the following types of clashes are to be submitted to HDB 

using the template provided for record: 

 Clashes in areas where clash detection is mandatory; 

 Significant clashes in other areas; 

 Clashes which the project team had agreed to ignore due to excessive modelling 

efforts required. 

 

It is mandatory to carry out clash detection at the following areas of a residential unit: 

 Wet Areas (between Arch, CS and MEP) 

 Service Yards (between Arch and MEP) 

 Access to Air-Con Ledges (between Arch and MEP) 
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4.4 Modelling Rules for Clash Detection 
 This section defines the modelling rules for the 4 primary elements and serves as a checklist 

for performing clash detection between these key elements.  Performing clash detection 

should form part of the quality assurance for all new public housing developments. 

 

 Note: This section does not cover clash detection with M&E services. However, clash 

detection with M&E services should still be performed to ensure quality of the model and to 

reduce the reworks downstream. 

 

ELEMENT COLUMN BEAM SLAB WALL 

COLUMN COLUMN-COLUMN 

 
Elevation 

 

 No overlap 

 Model from 
Structural Floor to 
Structural Floor level 
 

   

BEAM BEAM-COLUMN 

 
Plan 

 

 Model from span to 
span 

BEAM-BEAM 

 
 

Plan 

 

 Model from span to 
span 
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ELEMENT COLUMN BEAM SLAB WALL 

SLAB SLAB-COLUMN 

 
Plan 

 

 Model to edge of 
Column after tender 
award 

SLAB-BEAM 

 
Plan 

 

 Model to edge of 
Beam (if Beams are 
shown in model) 
after tender award 
 

 
 
 

 

WALL WALL-COLUMN 

 
 

Plan 

 

 Model to edge of 
Column 

WALL-BEAM 

 
Section 

 

 Model to soffit of 
Beam (if Beams are 
shown in model) 
Otherwise, model to 
soffit of Slab. 
 

WALL-SLAB 

 
Section 

 

 Model to soffit of 
Slab or from SFL to 
SFL for Structural 
Wall 

WALL-WALL 

 
Plan 

 

 Model to centre of 
Wall 
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PART I: APPENDIX 1 

I.1.1 Core Information for BIM Objects  
 

Note: 

1. The Core Information (CI) for the list of BIM objects in this section defines the minimum 

data required from the Consultants' BIM models during Tender for use by the Contractor 

for new public housing developments during construction. 

2. The attributes must be attached to the BIM elements as parameters. 

 

Definition of Terms Used: 

Building Element Refers to the actual physical element constructed on site by the 
Contractors. 

BIM Object Refers to the Revit object/family to be used to create the building 
element in the model. 

Modelling 
Requirements 

Defines how the BIM object needs to be modelled in order to be 
useful for the Contractors for downstream BIM uses. 

2D View 
Requirements 

Indicates the 2D view that is derived from the BIM model. 

This is the minimum requirement to be provided so that Consultants 
need not produce views/drawings that are not necessary for the 
Contractors. 

Parameters Refer to the attributes/parameters required by the Contractor for 
their shop drawing production and downstream BIM uses. 

 

Name: Name of the parameter (specific to Revit software) 

Data List: Valid list of values for each parameter 

Purpose: Reason why this parameter is required. Possible reasons 
 include: 

 Identification 

 Setting Out 
 Costing 

 Coordination 

 Shop Drawing 

 CBP (Concrete Body Plan) 
 Contractor’s Use 

Remark: Any other specific remark in particular to the parameter. 

 

* All Parameters are "Mandatory" except for those listed under 
"Optional". 
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I.1.2 Core Information for Architectural Objects  
 

Building Element Column Wall Floor 

BIM Object Column: Architectural Wall: Architectural / Wall: Structural 
Wall Opening 

Floor: Architectural 

Modelling Requirements • Model the columns individually for each storey/level. 
• Model the core element from SFL to SFL of above floor. 
• The dimensions of core element to match the structural model. 

• Model the walls individually for each storey/level. 
• Structural walls model the core from SFL to SFL of above floor. The core 

thickness to match the structural model. 
• Architectural walls model from SFL to soffit of floor or beam above. 

• Indicate the FFL. 
• Match the top of core to the SFL of structural model. 
• Model Openings, if any. 

2D View Requirement Plans showing the location of each column for setting out Plans showing the location of each wall for setting out Plans showing the extent of the floor slab 

Parameters Name Data List Purpose Remarks Name Data List Purpose Remarks Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   ID   Identification   ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Base Level   Coordination Base Reference 
Level 

Base 
Constraint 

  Coordination Base Reference 
Level 

Level   Coordination   

Base Offset   Coordination   Base Offset   Coordination   Height Offset 
From Level 

  Coordination   

Top Level   Coordination   Top 
Constraint 

  Coordination   Dimensions   •  Costing 
•  Coordination 
•  Shop Drawing 

Thickness 

Top Offset   Coordination   Top Offset   Coordination     
  
  

Dimensions   • Costing 
• Setting-out 
• Coordination 
• Shop Drawing 

Diameter x Height 
or 
Length x Width x 
Height 

Dimensions   • Costing 
• Setting-out 
• Coordination 
• Shop Drawing 

Thickness x Length 
x Height 

Manual Entry 

 Finish 
Thickness 

  • Costing 
• Setting-out 
• Coordination 
• Shop Drawing 

  Finish 
Thickness 

  • Costing 
• Setting-out 
• Coordination 
• Shop Drawing 

 Finish 
Thickness 

  • Costing 
• Setting-out 
• Coordination 
• Shop Drawing 

  

Material   Costing Core & Finish 
Material 

Material   Costing Core & Finish 
Material 

Material   Costing Core and Finish 
Material 

 Construction 
Method 

Follow 
BScore List 

• Buildable Design 
Score 

• Contractor's Use 

*NEW 
(Manual Entry) 

Construction 
Method 

Follow 
BScore List 

• Buildable Design 
Score 

• Contractor's Use 

*NEW 
(Manual Entry) 

Calculated 

  Length   Costing    

Optional 

 Block 
Number 

  Contractor's Use *NEW 
(Manual Entry) 

Block 
Number 

  Contractor's Use *NEW 
(Manual Entry) 

Block 
Number 

  Contractor's Use *NEW 
(Manual Entry) 

Unit Type   Contractor's Use *NEW 
(Manual Entry) 

Unit Type   Contractor's Use *NEW 
(Manual Entry) 

Unit Type   Contractor's Use *NEW 
(Manual Entry) 

 Parapet • Yes 
• No 

Contractor's Use *NEW 
(Manual Entry) 

 

Fire Rating   • Costing 
• Contractor's Use 
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I.1.2 Core Information for Architectural Objects  
 

Building Element Door Window Railing 

BIM Object Door Window Railing 

Modelling Requirements • Door opening to follow Structural opening. 
• Location to be based on the Room 'from' which the Door opens. 
• Door to be coordinated with Structural Openings if in Structural Wall. 
• Main Entrance Gates to be modelled as part of Main Door. 
• Ironmongery may be provided as Specification (parameter) and does not 

need to be modelled. 

• Window opening to follow Structural opening. 
• Location to be based on the Room 'from' which the Window opens. 
• Window to be coordinated with Structural Openings if in Structural Wall. 
• Do not over model. Specifications (parameter) may be used for details. 

• Model handrail only (not representative). Actual design to refer to HDB's 
guide detail drawings. 

2D View Requirement Plan showing the location of each door with identification Plan showing the location of each window with identification Plan showing location of railing with identification 

Parameters Name Data List Purpose Remarks Name Data List Purpose Remarks Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   ID   Identification   ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Level   Coordination   Level   Coordination   Base Level   Coordination   

Sill Height   Coordination   Sill Height   Coordination   Base Offset   Coordination   

Dimensions   • Costing 
• Coordination 
• Shop Drawing 

Width x Height 
(Structural 
Opening) 

Dimensions   • Costing 
• Coordination 
• Shop Drawing 

Width x Height 
(Structural 
Opening) 

Tread/ 
Stringer 
Offset 

  Coordination   

  Railing Height   Coordination   

Manual Entry 

 Door Type   • Costing 
• Shop Drawing 

Type Name Window Type   • Costing 
• Coordination 
• Shop Drawing 

Type Name Railing Type   Shop Drawing Type Name 

Door 
Description 

  • Costing 
• Shop Drawing 

Type Name Window 
Description 

  • Costing 
• Shop Drawing 

Type Name Railing 
Description 

  Shop Drawing Type Name 

Function   Contractor's Use   Window 
Schedule 

  • Costing 
• Contractor’s Use 

*NEW 
(Graphical Window 
Schedule not 
required) 

 

Fire Rating   Costing    

Door 
Schedule 

  • Costing 
• Contractor’s Use 

*NEW 
(Graphical Door 
Schedule not 
required) 

Calculated 

   Railing Length   • Costing 
• Contractor’s Use 

  

Optional 

 Block 
Number 

  Contractor's Use *NEW 
(Manual Entry) 

Block 
Number 

  Contractor's Use *NEW 
(Manual Entry) 

Block 
Number 

  Contractor's Use *NEW 
(Manual Entry) 

Unit Type   Contractor's Use *NEW 
(Manual Entry) 

Unit Type   Contractor's Use *NEW 
(Manual Entry) 

Railing 
Location 

  Contractor's Use *NEW 
(Manual Entry) 

Door Location   Contractor's Use *NEW 
Room Name 
(Manual Entry) 

Window 
Location 

  Contractor's Use *NEW 
Room Name 
(Manual Entry) 
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I.1.2 Core Information for Architectural Objects  
 

Building Element Ramp Staircase Roof 

BIM Object Ramp Stair Roof 

Modelling Requirements  For HDB MSCP driveway ramps, use 'Ramp' for Architectural Model and 
use 'Slab' for Structural Model. 

 Structural Model to create ramp based on Architectural Model. 

   For Flat Roofs, Roof Tops and Walkways, use 'Roof' to model element. 

2D View Requirement Plan showing location of ramp with identification Plan showing location of staircase with identification Plan showing location of roof with identification 

Parameters Name Data List Purpose Remarks Name Data List Purpose Remarks Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   ID   Identification   ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Base Level   Coordination   Base Level   Coordination   Base Level   Coordination   

Base Offset   Coordination   Base Offset   Coordination   Base Offset 
From Level 

  Coordination   

Top Level   Coordination  Top Level   Coordination  Slope   • Costing 
• Coordination 
• Shop Drawing 

  

Top Offset   Coordination  Top Offset   Coordination  Thickness   • Costing 
• Coordination 
• Shop Drawing 

 

Width   • Costing 
• Coordination 
• Shop Drawing 

 Maximum 
Riser Height 

  • Coordination 
• Shop Drawing 

  

Thickness   • Costing 
• Coordination 
• Shop Drawing 

 Minimum 
Run Width 

  • Coordination 
• Shop Drawing 

 

Ramp Max 
Slope 

  Coordination  Number of 
Risers 

  • Coordination 
• Shop Drawing 

 

Manual Entry 

 Function   Contractor's Use   Construction 
Method 

Refer to 
Data 
Dictionary 

Contractor's Use *NEW Material   • Costing 
• Coordination 
• Shop Drawing 

  

Ramp 
Material 

  • Costing 
• Contractor’s Use 
 

    

Construction 
Method 

Refer to 
Data 
Dictionary 

Contractor's Use *NEW 

Calculated 

   Area   Costing  

Volume   Costing  

Optional 

  Block 
Number 

  Contractor's Use *NEW 
(Manual Entry) 

Block 
Number 

  Contractor's Use *NEW 
(Manual Entry) 

  Description    Contractor's Use Manual Entry  

Function   Contractor's Use Manual Entry 

NOTES: 

a. All objects are to be modelled regardless if they are Precast / Cast-in-Situ / etc. Thus, Household-Shelters, Service Duct, Trucking, etc. are to be modelled in its equivalent existence such as Walls. 

b. All Architectural Elements modelled are to be checked against the PRECAST MODEL as well as STRUCTURAL MODEL for consistency in size, location and properties.  
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I.1.3 Core Information for Structural Objects  
 

Building Element Pile Pile Cap Column 

BIM Object Isolated Foundation Isolated Foundation 
Structural Foundation: Wall 
Structural Foundation: Slab 

Column 

Modelling Requirements • Model the piles separately from the pile cap for non-standard types of piles. 
• Model the piles to the design intent length. 

• Foundation shall be modelled to the exact dimension and levels. • Model the structural column individually for each storey. 
• Model the columns from SFL to SFL of floor above. 
• Model the stumps (portion between the pile cap/footing and level 1 column) 

separately. 
• Include drop panel, corbel, etc… 
• Use library/objects for non-standard columns. Avoid using model-in-place. 

2D View Requirement • Plans showing the location of each pile for setting out 
• Schedules or details with reinforcement information 
• Connection details 

• Plans showing the location of each pilecap with identification for setting out 
• Schedules or details with reinforcement information 
• Connection details 

• Plan showing the location of each column with identification for setting out 
• Schedules or details with reinforcement information 
• Connection details 

Parameters Name Data List Purpose Remarks Name Data List Purpose Remarks Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   ID   Identification   ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Level   • Setting Out 
• Coordination 

Based on AMSL to 
calculate pile cut-off 
level 

Level   • Setting Out 
• Coordination 

  Base Level   • Setting Out 
• Coordination 

  

Offset   • Setting Out 
• Coordination 

  Height Offset 
From Level 

  • Setting Out 
• Coordination 

  Base Offset   • Setting Out 
• Coordination 

  

Dimensions   • Costing 
• Coordination 
• CBP 

Diameter x Length Dimensions   • Costing 
• Coordination 
• CBP 

Length x Width x 
Thickness 

Top Level   • Setting Out 
• Coordination 

  

  
  
  

  
  
  
  

Top Offset   • Setting Out 
• Coordination 

  

Dimensions   • Costing 
• Coordination 
• CBP 

Diameter x Height 
or Length x Width x 
Height 

Manual Entry 

 Embedment   • Costing 
• CBP 

  Construction 
Method 

Refer to Data 
Dictionary 

• Costing 
• Contractor’s Use 

*NEW Construction 
Method 

Refer to Data 
Dictionary 

• Costing 
• Contractor’s Use 

*NEW 

Depth   • Costing 
• Coordination 
• CBP 

    

Pile Type Refer to 
Data 
Dictionary 

• Costing 
• Coordination 
• CBP 

*NEW 

Calculated 

 Pile Cut-off 
Level 

  Setting Out *NEW 
(Calcuated by Main 
Contractor based on 
Level and Offset) 

  

Optional 

 Loading   Contractor's Use *NEW 
(Manual Entry) 

Block Number   Contractor's Use *NEW (Manual Entry) Block Number   Contractor's Use *NEW (Manual Entry) 

Concrete 
Grade 

  Costing *NEW 
(Manual Entry) 

Number of Piles   Contractor's Use *NEW(Manual Entry) Properties Type Refer to Data 
Dictionary 

Contractor's Use *NEW (Manual Entry) 

  Loading   Contractor's Use *NEW (Manual Entry) Unit Type   Contractor's Use *NEW (Manual Entry) 

Concrete Grade   Costing *NEW (Manual Entry) Loading   Contractor's Use *NEW (Manual Entry) 

  
  

Concrete Grade   Costing *NEW (Manual Entry) 

Column 
Schedule Ref.   

Contractor's Use *NEW (Manual Entry) 
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I.1.3 Core Information for Structural Objects  
 

Building Element Beam  (including capping beam) Floor/SLab Wall 

BIM Object Beam Floor: Structural 
Floor: Slab Edge 

Walls: Structural 
Wall Opening 

Modelling Requirements • Model the beams from and to the centre of the column. 
• Join beams to slabs (clear the connections). 
• Model beam haunches to designed dimensions. 
• Model proper termination of beams. 
• Model structural openings, if any. 

• Model the structural floors at SFL. 
• Model slabs as individual elements from beams after tender award. 
• Openings to be modelled on floor. Not to use special tools to create the 

openings. E.g. Shafts Voids, etc. 
• Model hollow-core slabs. 
• Model structural foundation slabs. 
• Model the slab edges with the exact profile. 
• Show direction of span in model for one-way span. 
• Optional: Model the recesses, kerbs, pads, trenches, cut-off drains, slab drops. 

• Model the structural walls from SFL to the SFL of floor above. 
• Model structural foundation wall where necessary. 
• Model openings using the Wall Opening tool, not by editing the wall's elevation 

profile. 

2D View Requirement • Plan showing the location of each beam  with identification for setting out 
• Indicate beam drops in plan view 
• Schedules or details with reinforcement information 
• Connection details 

• Plans showing the location of each slab with identification  
• Plans showing reinforcement information 
• Loading Plan 

• Plans showing the location of each wall with identification for setting out 
• Schedules or details with reinforcement information 
• Connection details 

Parameters Name Data List Purpose Remarks Name Data List Purpose Remarks Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   ID   Identification   ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Reference 
Level 

  • Setting Out 
• Coordination 

  Level   • Setting Out 
• Coordination 

  Base 
Constraint 

  • Setting Out 
• Coordination 

  

Start Level 
Offset 

  • Setting Out 
• Coordination 

  Height Offset 
From Level 

  • Setting Out 
• Coordination 

  Base Offset   • Setting Out 
• Coordination 

  

End Level 
Offset 

  • Setting Out 
• Coordination 

  Dimensions   • Costing 
• Coordination 
• CBP 

Thickness Top Constraint   • Setting Out 
• Coordination 

  

z-Offset Value   • Setting Out 
• Coordination 

    Top Offset   • Setting Out 
• Coordination 

  

Dimensions   • Setting Out 
• Coordination 
• CBP 

Length x Width x 
Depth 

Dimensions   • Costing 
• Coordination 
• CBP 

Height 
Thickness 
Length 

Manual Entry 

 Construction 
Method 

Refer to 
Data 
Dictionary 

• Costing 
• Contractor’s Use 
 

*NEW Span Direction •  One 
•  Two 

Contractor's Use *NEW Construction 
Method 

Refer to 
Data 
Dictionary 

• Costing 
• Contractor’s Use 
 

*NEW 

 Construction 
Method 

Refer to 
Data 
Dictionary 

• Costing 
• Contractor’s Use 
 

*NEW  

Calculated 

    

Optional 

 Block Number   Contractor's Use *NEW 
(Manual Entry) 

Block Number   Contractor's Use *NEW 
(Manual Entry) 

Function   Contractor's Use Manual Entry 

Properties 
Type 

Refer to 
Data 
Dictionary 

Contractor's Use *NEW 
(Manual Entry) 

Properties 
Type 

Refer to 
Data 
Dictionary 

Contractor's Use *NEW 
(Manual Entry) 

Block Number   Contractor's Use *NEW 
(Manual Entry) 

Unit Type   Contractor's Use *NEW 
(Manual Entry) 

Unit Type   Contractor's Use *NEW 
(Manual Entry) 

Unit Type   Contractor's Use *NEW 
(Manual Entry) 

Concrete 
Grade 

  Costing *NEW 
(Manual Entry) 

Concrete 
Grade 

  Costing *NEW 
(Manual Entry) 

Concrete 
Grade 

  Costing *NEW 
(Manual Entry) 
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I.1.3 Core Information for Structural Objects  
 

Building Element Staircase 

BIM Object Stair 

Modelling Requirements  

2D View Requirement • Plans showing the location of each ramp/stair with identification for setting out 
• Detail with reinforcement information 

Parameters Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Base Level   • Setting Out 
• Coordination 

 

Base Offset   • Setting Out 
• Coordination 

 

Top Level   • Setting Out 
• Coordination 

 

Top Offset   • Setting Out 
• Coordination 

 

Maximum 
Riser Height 

  • Setting Out 
• Coordination 
• Shop Drawing 

 

Minimum Run 
Width 

  • Setting Out 
• Coordination 
• Shop Drawing 

 

Number of 
Risers 

  • Setting Out 
• Coordination 
• Shop Drawing 

 

Manual Entry 

 Construction 
Method 

Refer to 
Data 
Dictionary 

• Costing 
• Contractor’s Use 
 

*NEW 

Calculated 

  

Optional 

 Block Number   Contractor's Use *NEW 
(Manual Entry) 

Concrete 
Grade 

  Costing *NEW 
(Manual Entry) 

NOTES: 

a. Concrete Grade is an optional parameter as Consultants generally indicate the Concrete Grade in the form of 'Notes'. 

b. Use the recommended BIM Objects to model the elements. E.g. do not use Slab or Floor to model Beam. 
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I.1.4 Core Information for MEP Objects 
PIPEWORK 
Building Element Pipe Pipe Fitting 

(include elbows, tees, crosses, unions etc.) 

BIM Object Pipe Pipe Fitting 

Modelling Requirements     

2D View Requirement Plans showing the location of each pipe for setting out   

Parameters Name Data List Purpose Remarks Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Reference 
Level 

  Coordination   Level   Coordination   

Offset   Coordination   Offset   Coordination   

Slope   Coordination   Size   • Costing 
• Coordination 

  

Size   • Costing 
• Coordination 

Diameter  

Manual Entry 

 System Type   • Coordination 
• Contractor's Use 

  System 
Classification 

  • Coordination 
• Contractor's Use 

  

Pipe Segment   Costing    

Material   Costing    

Insulation 
Size 

  Costing    

Calculated 

   

Optional 
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I.1.4 Core Information for MEP Objects  
PLUMBING FIXTURE 
Building Element Plumbing Fixture 

BIM Object Plumbing Fixture 

Modelling Requirements   

2D View Requirement Plans showing the location of each fixture  with identification 

Parameters Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Level   Coordination   

Elevation/ 
Offset 

  Coordination   

Dimensions   Costing   

Manual Entry 

 System 
Classification 

  Contractor's Use   

Pipe 
Connector 

  • Costing 
• Coordination 

*NEW 

Calculated 

  

Optional 
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I.1.4 Core Information for MEP Objects  
FIRE PROTECTION 
Building Element Sprinkler 

BIM Object Sprinkler 

Modelling Requirements   

2D View Requirement Plans showing the location of each sprinkler with identification 

Parameters Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Offset   Setting Out   

Manual Entry 

 System 
Classification 

  Contractor's Use   

Sprinkler 
Type 

  Contractor's Use *NEW 
(Type Name) 

Pipe 
Connector 

  • Costing 
• Coordination 

*NEW 

Calculated 

  

Optional 
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I.1.4 Core Information for MEP Objects  
ELECTRICAL 
Building Element Cable Tray / Trunking / Ladder Conduit Electrical Equipment 

(includes panels and switchgears) 

BIM Object Cable Tray Conduit Electrical Equipment 

Modelling Requirements       

2D View Requirement Plans showing the location of the cable tray, trunking and ladder Plans showing the location of the conduit Plans showing the location of the electrical equipment with identification 

Parameters Name Data List Purpose Remarks Name Data List Purpose Remarks Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   ID   Identification   ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Reference 
Level 

  Coordination   Reference 
Level 

  Coordination   Offset   Coordination   

Offset   Coordination   Offset   Coordination   Dimensions   Coordination   

Dimensions   • Costing 
• Coordination 

Width x Height Dimensions   • Costing 

• Coordination 

Diameter 
Length 

  

Manual Entry 

 Fittings   • Costing 
• Coordination 

Bends, Tee, Cross, 
Transition, Union 

Fittings   • Costing 

• Coordination 

Bends, Tee, Cross, 
Transition, Union 

Load 
Classification 

  Contractor's Use *NEW 

   Conduit Type   Contractor's Use Type Name    

Calculated 

     

Optional 
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I.1.4 Core Information for MEP Objects  
ELECTRICAL 
Building Element Electrical Device 

(include receptacles, junction boxes and other power devices) 
Electrical Device 

(include intercom system components) 
Electrical Device 

(include data devices e.g. Ethernet and other network connections) 

BIM Object Electrical Fixture Communication Data 

Modelling Requirements       

2D View Requirement Plans showing the location of the electrical device with identification Plans showing the location of the electrical device with identification Plans showing the location of the electrical device with identification 

Parameters Name Data List Purpose Remarks Name Data List Purpose Remarks Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   ID   Identification   ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Elevation   Coordination   Elevation   Coordination   Elevation   Coordination   

Dimensions   Coordination If Applicable Dimensions   Coordination If Applicable Dimensions   Coordination If Applicable 

Manual Entry 

 Load 
Classification 

  Contractor's Use *NEW   

Calculated 

     

Optional 
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I.1.4 Core Information for MEP Objects  
ELECTRICAL 
Building Element Electrical Device 

(include fire alarm devices such as smoke detectors, manual pull stations 
and annunciators) 

Electrical Device 
(include daylight sensors, occupancy sensors and manual switches) 

Electrical Device 
(include security devices such as door locks, motion sensors and 

surveillance cameras) 

BIM Object Fire Alarm Lighting Switch Security 

Modelling Requirements       

2D View Requirement Plans showing the location of the electrical device with identification Plans showing the location of the electrical device with identification Plans showing the location of the electrical device with identification 

Parameters Name Data List Purpose Remarks Name Data List Purpose Remarks Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   ID   Identification   ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Default Geometric Parameter (Required for placing the elements in the model) 

 Elevation   Coordination   Elevation   Coordination   Elevation   Coordination  

Dimensions   Coordination If Applicable Dimensions   Coordination If Applicable Dimensions   Coordination Dimensions 

Manual Entry 

    

Calculated 

     

Optional 
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I.1.4 Core Information for MEP Objects  
ELECTRICAL 
Building Element Electrical Device Lighting Fixture 

BIM Object Telephone Lighting Fixture 

Modelling Requirements     

2D View Requirement Plans showing the location of the electrical device with identification Plans showing the location of the electrical device with identification 

Parameters Name Data List Purpose Remarks Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Elevation   Coordination   Elevation   Coordination   

Dimensions   Coordination If Applicable Dimensions   Coordination If Applicable 

Manual Entry 

  Load 
Classification 

  Contractor's Use *NEW 

Calculated 

    

Optional 
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I.1.4 Core Information for MEP Objects  
ACMV 
Building Element Duct Air Terminal Mechanical Equipment 

(include pumps and pressure tanks) 

BIM Object Duct Air Terminal Mechanical Equipment 

Modelling Requirements       

2D View Requirement Plans showing the location of each air terminal with identification for 
setting out 

Plans showing the location of each air terminal with identification for 
setting out 

Plans showing the location of each mechanical equipment with 
identification 

Parameters Name Data List Purpose Remarks Name Data List Purpose Remarks Name Data List Purpose Remarks 

Default Non-Geometric Parameter (Required for placing the elements in the model) 

 ID   Identification   ID   Identification   ID   Identification   

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

Name   Identification Family Name/Type 
Name/Object Name 

  
  

System 
Classification 

  Coordination   System 
Classification 

  Coordination   

Default Geometric Parameter (Required for placing the elements in the model) 

 Reference 
Level 

  Coordination   Level   Coordination   Offset   Coordination   

Offset   Coordination   Offset   Coordination   Dimensions   Coordination   

Dimensions   •  Costing 
•  Coordination 

Width x Height Dimensions   •  Costing 
•  Coordination 

Width x Height   

Manual Entry 

 System Type   Coordination    Electrical 
Load 

  Contractor's Use   

Calculated 

 Bottom 
Elevation 

  Coordination      

Optional 

 Mechanical 
Flow 

  Contractor's Use Manual Entry Mechanical 
Flow 

  Contractor's Use Manual Entry Mechnical 
Flow 

  Contractor's Use Manual Entry 
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I.1.5 Data Dictionary for Core Information Data List  
  

ATTRIBUTE DATA LIST DEFINITION OF TERM 
Type of Pile Bored Bored Pile 
 Composite Composite Pile 

 Micro Micro Pile 

 PC Precast Pile 

 Sheet Sheet Pile 
   

Construction Method CIS Cast-In-Situ 
 Composite Composite/Fabricated 

 PC Precast 

   

Properties Type Normal --- 
 Prestressed --- 

 RC Reinforced Concrete 

 

 

I.1.6 Classification for MEP Disciplines and Sub-Disciplines  
 The table below shows the classification for MEP disciplines and sub-disciplines to be used 

when modelling MEP objects to ensure consistency.  

 

DISCIPLINE SUB-DISCIPLINE ABBREVIATION 

PLUMBING Cold Water Supply CWS 
 Hot Water Supply HWS 
 Sanitary SANITARY 
 Rain Water Down Pipe RWDP 
 Hose Reel HR 
 Wet Riser WR 
 Sprinkler System SPR 
 Gas GAS 
ELECTRICAL Electrical Cable ECAB 
 Telecom TELECOM 
 Cable Tray CTRAY 
 Cable Ladder CLAD 
 Cable Trunking CTRUNK 
 Cable Enclosure CENCLOSE 

MECHANICAL Fresh Air Duct FAD 
 Supply Air Duct SAD 
 Kitchen Fresh Air Duct KFAD 
 Kitchen Exhaust Air Duct KEAD 
 Exhaust Air Duct EAD 
 Return Air Duct RAD 
 Toilet Exhaust Airt Duct TEAD 
 Toilet Return Air Duct TRAD 
 Condensing Water Supply CWS 
 Condensing Water Return CWR 
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I.1.7 MEP Pipe Material & Sizes for Housing Projects  
The table below shows the MEP pipe material and sizes commonly used in new public 

housing developments. 

Note: 

Please note that these are for reference only and  shall not relieve the Qualified Person of 

his obligations and responsibilities in ensuring that the design complies fully with HDB’s and 

all relevant authorities’ requirements. 

 

This information is compiled from the HDB Guide Drawings and HDB Building Specifications 

and is correct as of the 2014 version. 

 

Plumbing Pipework 

SYSTEM TYPE SIZE MATERIAL 
(STANDARDS) 

TYPES OF JOINTS 
(STANDARDS) 

Cold Water Ø80mm and 
above 

Ductile Iron Cement Lined Pipe  

(BS EN 545) 

PN16 ductile iron flange joints 

(BS EN 545) 

Ø54mm / 
Ø42mm 

Stainless Steel Pipe 

(BS EN 10312:02) 

Compression fittings of copper 
alloy (BS EN 1254 Part 2:1998)  

/ 

Stainless steel press fitting joints 
(Japanese Waterworks 
Association G116) 

Hot / Cold Water 
(within dwelling unit 
for sold flats) 

Ø28mm / 
Ø22mm 

Copper Pipe 

(BS EN 1057-R250) 

Press-fitting joints 

(BS EN 1254 Part 2) 

Hosereel Supply Tee-
Off from Potable 
Water Tank 

Ø54mm Stainless Steel Pipe  

(BS EN 10312:02) 

Compression fittings of copper 
alloy (BS EN 1254 Part 2:1998)  

/ 

Stainless steel press fitting joints 
(Japanese Waterworks 
Association G116) 
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Sanitary Pipework 

Unless specified otherwise, all UPVC pipes and fittings provided for sanitary installations 

shall be in accordance with the following schedule: 

SANITARY INSTALLATION 
(INCLUDING WASTE/RAIN 
WATER DOWN-PIPE 
SYSTEM) 

TYPE OF PIPE/FITTING 

(SS: SINGAPORE STANDARD) 
REMARKS SS 213 SS 141 

Class D 
SS 272 

Underground Sanitary Drainage 
System – Main/Branch Drain 
Lines 

  * 

 

Above Ground Sanitary Plumbing 
System (Soil/Waste to I/C): 

   Anti-Mosquitoes Devices, 
Socket Sleeves and Pipe 
Skirtings to be used. 

SS 213/SS 141 Adaptor to be 
used. 

c. All except Void Decks *   

d. Void Decks 

 Discharge stacks 

 Discharge pipes & fittings 

 

 

* 

 

*  

Waste/Rain Water Down-Pipe 
System (RWDP): 

   
 

a. 200 diameter pipes for RWDP 
system 

  
* 

(White) 

Roof Outlet to be used. 

b. Underground pipes/fittings for 
200 diameter pipes (RWDP) 

   
Rectangular Section Fittings to 
be used. 

c. Above ground pipes/fittings 
connected to 200 diameter 
RWDP system 

* 

   

d. 50, 80, 100 & 150 diameter 
waste discharge (balcony, lift 
lobby, etc.) pipes/fittings: 

    

i. Above ground except void 
decks and MSCPs 

* 
   

ii. Void decks and MSCPs 

 Down pipes 

 Discharge pipes/fittings 

 Underground 
pipes/fittings 

 

 

* 

 

* 

 

 

 

* 

SS 213/SS 141 Adaptor to be 
used. 

 * Denotes the specified pipes/fittings. 

 

APPLIANCE/FITTING TYPE MINIMAL INTERNAL DIAMETER OF WASTE PIPE (mm) 

Wash Basin 32 

Kitchen Sink 40 

Floor Trap 100 

Floor Waste at Shower Area 50 
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Gas Pipework 

SYSTEM TYPE SIZE MATERIAL 
(STANDARDS) 

TYPES OF JOINTS 
(STANDARDS) 

Horizontal supply 
pipe outside 
dwelling unit/gas 
riser 

Ø50mm and 
above 

Galvanised steel pipes  
(SS 17 or BS 21) 

Galvanised malleable cast iron 
pipe fittings 
(BS 143 and BS 1256) 

Gas pipe (within 
dwelling unit) 

Ø22mm Copper Pipe 
(BS EN 1057) 

Compression fittings of copper 
alloy 
(BS EN 1254 Part 2) 

 

Fire Protection Pipework 

PIPE TYPE SIZE MATERIAL 

Dry Riser Pipe Ø150mm /  
Ø100mm 

Galvanised Steel Pipes 

(BS 1387 or ASTM A120 and BS 1740) 

Hosereel Pipe 
(at MSCP after 
hosereel tank) 

Ø50mm /  
Ø25mm 

Galvanised Steel Pipe 
(BS 1387) 
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5.0 GETTING STARTED IN MODELLING 

5.1 Project Template 
 A project template provides a starting point for new project. One can start a project with 

BCA's BIM e-Submission template(s) or customise BCA’s BIM e-Submission template(s) that 

incorporates their own office standards. 

 

  
  

The following settings can be customised in the template: 

 Browser organization 

 Views and View Template, 

 System family types (Wall and Slab), 

 Standard families (both 2D and 3D)  

 Line types, 

 Filters (for colour override), 

 Text types (3 sizes per type for both 1:50 and 1:100 
scales) 

 Units, 

 Dimension types, 

 Tags, 

 Keynotes, 

 Symbols, 

 Groups, 

 Parameters, 

 Fill types (Floor and Wall tile patterns),  

 Schedules and 

 Sheets 
 

The template can be refined and improved during the course 

of the project to use for future projects. 

 

Note:  

Setting up of the template is not in the scope of this document. Please refer to the software 

help file/manual to understand how to create the template file.   

  

Example: Wall Types 

Example: Text Types 

 



 

  34 

5.2 Transferring Parameters from HDB Core Info Templates 
 Consultants may transfer the core information parameters from the HDB sample core 

information templates to their own customised templates or project files as follows:  

a. Open both the HDB sample core information template and your own customised 

template or your project file. 

 

b. Go to your own customised template or project file. Under the Manage tab, select 

Transfer Project Standards under Settings. 

 
 

c. In the Select Items To Copy dialog box, select the HDB Core Information Template to 

copy the standards from. From the list, select Project Parameters. 
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For MEP, the Pipe Types should also be selected to copy the MEP pipe material and sizes 

commonly used in new public housing developments from HDB sample core information 

templates to your own customised templates or project files, if so desired. 

 
 

d. Click OK to finish. 

 

e. Add an object e.g. Structural Column (in this example, the standards are being 

transferred from the HDB Structural Core Information Template) to the project.  Click on 

the object and the Properties should show the parameters that have been transferred 

from the template. 
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5.3 Creating a Project Base Model 
 

Note:  

HDB’s surveyor will provide the Consultants awarded the project with the 3D topographical 

CAD drawing (for reference) and the BIM Site Topo Model for the development of their own 

models. 

 

However, HDB shall not be responsible for any costs, expenses, liabilities or damages which 

may result from the use of the CAD drawing and/or the BIM Site Topo Model.  

 

It is recommended that a Project Base Model be created based on the BIM Site Topo Model 

provided by HDB’s surveyor. The Project Base Model can be created using the BCA BIM  

e-Submission template or the company’s own customised template, as discussed under the 

section ‘Project Template’. 

 

The Project Base Model should be created by the lead consultant at the start of the project, 

shared and used by the other project team members to create their respective parts or 

disciplines for the project. This model shall contain the following information and shall show 

the complete layout of the proposed site when all the other relevant portions or disciplines 

are linked to this master layout: 

 Location of Site (as provided by Surveyor); 

 Site Boundary; 

 Orientation of Site according to True North; 

 Setting out of the proposed building(s) or a common reference point or grids to 

locate the proposed building(s) in relation to the site; 

 Proposed Platform Level or 1st Storey Level (Elevation) as agreed between the team 

members; 

 Proposed Levels for all upper storeys based on structural floor levels of residential 

units. 

 

It is recommended that the Structural and M&E teams set up their respective models using 

the Project Base Model as a common base first and inherit the coordinates and elevation 

from this model.  

 

This is to ensure that subsequently when they link in the Architectural Model(s) to create 

their respective discipline models using Shared Coordinates, the different models will align 

correctly. When all the models are linked to the Project Base Model, the respective 

disciplines should also be properly aligned and orientated according to the True North for 

the project site. 
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Overview of Suggested Workflow for Creating the Project Base Model and the various 

models for coordination: 

(Refer to the Steps for the details) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

* Models may be split into different blocks, depending on the size and complexity of project. Refer to 

the section on ‘Modelling Plan’ for more details.  

BIM Site Topo Model & 

3D CAD Topo Survey Drawing 

(from HDB’s Surveyor) 

Create Project Base Model 

 Link in BIM Site Topo Model 

 Acquire Coordinates 

 Copy Boundary Lines 

 Set up the Project North & True 

North 

 Set up the Elevation to agreed 

level 

 Set up Reference Point, Grids  

or proposed layout of 

building(s) 

Create Archi Model(s)* 

 Link in Project Base 

Model 

 Acquire Coordinates 

 Change Elevation 

Levels to Shared 

Datum 

 Copy the Site 

Boundary and 

Reference Point or 

Grids 

Create Struct Model(s)* 

 Link in Project Base 

Model 

 Acquire Coordinates 

 Change Elevation 

Levels to Shared 

Datum 

 Copy the Site Boundary 

and Reference Point or 

Grids 

 Link in the Archi 

Model(s) to create 

Struct Model(s) 

Create MEP Model(s)* 

 Link in Project Base 

Model 

 Acquire Coordinates 

 Change Elevation 

Levels to Shared 

Datum 

 Copy the Site 

Boundary and 

Reference Point or 

Grids 

 Link in the Archi 

Model(s) to create 

MEP Model(s) 

Revit Links between models  
(by Shared Coordinates) 
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Step 1: Create a new Project Base Model from the Project Template 

a. From the Application Menu choose New  Project. 

b. In the New Project dialog box, choose Project under Create new. 

c. Click the Browse... button and locate the template file using the file dialog box. 

d. Click OK to create the new project. 

 

 

 

 

 

 

 

 

 

 

Step 2: Acquire Coordinates from the BIM Site Topo Model  

The new project created in Step 1 is shown in the image below. Next, set up the Location 

and Orientation for the project. This is done by linking the Surveyor's BIM Site Topo Model 

into the site plan view and by acquiring the coordinates from the BIM Site Topo Model.  

Note: 

The Surveyor’s BIM Site Topo Model should have been set up to use a particular Survey 

Control Point as the Project Base Point so the new Project Base Model will acquire these 

coordinates from the BIM Site Topo Model. 
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a. Double-click on the view BCA-_SP_SITE to open the site plan view. 

 From the Insert Tab choose Link Revit. 

  
 

b. In the Import/Link RVT dialog box, browse and locate the BIM Site Topo Model in RVT 

format. 

 

c. Set the Positioning to Auto - Origin to Origin and click Open. This will place the 

topography of the project site in the site plan view in the location and orientation set by 

the Surveyor.  

 
 

d. Turn on the visibility of the Project Base Point under View -> Visibility/ Graphics -> 

Model Categories -> Site. The Project Base Point  shows the N/S and E/W coordinates 

to be 0.0. 
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e. You may not see anything in the drawing space even after linking the Revit BIM Site Topo 

Model. 

Click on Reveal Hidden Elements  in the View Control Bar. This should reveal the 3D 

CAD Topographical Survey drawing (which should have been linked to the BIM Site Topo 

Model) as shown in the image below. 

 
 

f. Go to the Manage tab, Project Location -> Coordinates and select Acquire Coordinates. 

Pick the linked file as revealed above to acquire the coordinates. The Project Base Point 

now shows the same coordinates as the Survey Control Point set up as the Project Base 

Point in the BIM Site Topo Model. 

   
 

 

  

Reveal Hidden Elements 
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Step 3: Copy the Boundary Lines from CAD Survey Drawing 

With the 3D CAD Topographical Survey drawing still revealed, copy the boundary line from 

the drawing.  

 

a. Go to the Massing & Site tab, Modify Site -> Property Line. In the Create Property Line 

dialog, select Create by sketching.  

   
 

b. Use the Line or the Pick Lines tool to copy the boundary lines from the CAD drawing. 

  
 

c. Click on the Reveal Hidden Elements  in the View Control Bar again to hide the 3D 

CAD drawing if so desired.  
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Step 4: Set Up Orientation for Project 

Next set up the orientation for the site. The survey drawing is normally based on the real 

world north (pointing upwards). Make sure that it is correct. However, it may not be 

convenient for the team to work in the real world north orientation. Revit offers Project 

North and True North as a solution. 

 True North in Revit represents real world north orientation.  

 Project North is specified by the user, which can be set for convenience to work on 

the building model. It is like rotating a paper to a convenient position to draw. 

 

Note:  

In Revit there is only one Project North per file. If there are multiple blocks, either one of the 

options described below could be used. 

 

Option 1: Create individual files for each block, in which the Project North can be set 

differently for each of them. Link the files (blocks) to form the overall model. In this option 

the documentation should be done in the individual files. 

 

Option 2: This is done in the file containing the overall model. Set the Project North based 

on the key block in the project. For the rest of the blocks, create the plan views, enable the 

crop region, select and rotate the crop region to the convenient orientation. 

 

a. In the previous Step, the BIM Site Topo Model was linked to the new Project Base Model 

with the Orientation set at the default Project North. 

 
 

 The Project Base Model has to be rotated to reflect the Project North. Select a boundary 

line that is parallel to the longitudinal side of the proposed building as a base for 

orientation. At the end of the settings that boundary line will be horizontal in the Project 

North. 
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b. Draw a line from the Project Base Point parallel to the site boundary that needs to be 

horizontal in the Project North. This line will be used as a Reference Line to set the 

orientation for the Project North. 

  
 

c. Select the Boundary Lines. In the Modify | Multi-Select tab, choose Rotate.  

 
 

d. A Rotation Point with a handle line will appear in the drawing area. Click on the Rotation 

Point and move it to the Project Base Point. 

  
 

  

Reference Line parallel to 
boundary line 

Horizontal Line 
(new position) 

Boundary Line 
(proposed building line 
will be parallel to this 
Boundary Line) 

Rotation Point 
with handle line 

Project Base Point 
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e. Click a point along the Reference Line as the rotate start point and click on the Horizontal 

Line (new position) as the 2nd point. 

     
 

f. The rotated project site will be as shown below.  

 
 

g. Next the user needs to set True North for the project.  Set the Properties -> Orientation 

of the view to True North. 

 
 

h. Select both the Toposurface and the Boundary Lines again. Go to Manage tab, Project 

Location -> Position and Rotate True North. 

 

 

 

 

 

 

 

 

 

 

 

 

  

Reference Line – 
rotate start 

Horizontal Line – 
2nd click point 
(new position) 
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i. This time, pick the Horizontal Line as the rotate start first. Then click the 2nd point on the 

Reference Line (new position). 

   
    

j. Once both Project North and True North for the project are set, verify that they are set 

correctly by changing the Orientation property of the view. 

  
 Orientation: Project North  Orientation: True North 

 

 The Project Base Point now shows the Angle to True North as well. 

 
  

Reference Line – 
2nd click point 
(new position) 

Horizontal Line – 
rotate start 
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Step 5: Set Up the Elevation Level to the Agreed Level 

a. Move the Elevation markers to outside of the project site if necessary. 

 
 

b. Go to the Elevation view to set the level to the agreed 1st Storey Level for the project. The 

linked BIM Site Topo Model will show the toposurface “floating” above the Elevation 

levels as shown. 

  
If the Elevation Levels cannot be seen, change the Properties -> Far Clipping of the view 

to No clip.  

    
 

c. Turn on the visibility of the Project Base Point.  The Elev shows 0.0. 

 
 

  

Toposurface (BIM 
Site Model) 

Elevation Levels 
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d. Select all the Levels and change the Properties to Level Circle Head – Shared Datum.    

   
 

e. With the Levels still selected, go to Manage -> Project Location -> Position and select 

Relocate Project.   

  
 

f. Pick the end point of the 1st Storey Level and enter the level of the 1st Storey Level in 

mm vertically as agreed between the Consultants (common reference level).   

   
 

g. The 1st Storey is now set to the agreed level based on the AMSL notation. The 

toposurface is also now set correctly. 
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Step 6: Set Up the Reference Grids, Point or Proposed Building Layout 

a. Go to the Site View and change the Properties -> Orientation to Project North. 

 
 

b. Create the Reference Grids or Point for the building layout e.g. one corner of the building. 

Set out the building layouts with the necessary building setbacks from the boundary lines 

as required. 

 

    
 

The Project Base Model should be distributed to the project team members as a common 

reference base model to set up the project 
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5.4 Creating Other Models  
Once the Project Base Model has been created and set up properly, this can then form a 

basis for the creation of the other models e.g. Massing, Architectural, Structural and MEP 

Models.  The other models can be created by linking in the Project Base Model and acquiring 

coordinates from the Project Base Model. 

Step 1: Create Other Models  

a. Create a new project for the Archi Model as in Section 5.3, Step 1 of the Guide. 

 

b. Double-click on the view BCA-_FP_1ST STOREY to open the 1st Storey plan view. 

 

c. From the Insert Tab choose Link Revit. 

  
 

c. In the Import/Link RVT dialog box, browse and locate the Project Base Model in RVT 

format. Set the Positioning to Auto - Origin to Origin and click Open.  

 
 

d. Click on Reveal Hidden Element and the Project Base Point will be shown as 0.0. 

 
 

e. Go to the Manage tab, Project Location -> Coordinates and select Acquire Coordinates. 

Pick the linked Project Base Model file to acquire the coordinates. The Project Base Point 

now shows the same coordinates as the as the Project Base Model. 
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f. Go to the Elevation view. The Project Base Model’s Elevation Levels and the Archi 

Model’s Elevation Levels are as shown. 

 
 

 

g. Select all the Archi Model’s Elevation Levels. Change the Properties to Level Circle Head – 

Shared Datum. The Archi Model’s Elevation Levels will be changed to the same as that of 

the Project Base Model. 

 
 

h. Copy the Boundary Lines and the Reference Grids from the Project Base Model. 

 

i. Create the Structural and MEP Models using the same steps above. Now all the models 

should share the same coordinates, Project North, True North and Elevation Levels as the 

Project Base Model. 

 

  

Project Base Model 
Elevation Levels – 103.00 m 

Archi Model 
Elevation Levels – 0.00m 
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j. Link in the Archi Model to the Structural and MEP Models using Auto – By Shared 

Coordinates. The Archi Model should be aligned with the MEP Model.  

 

The Consultants can now proceed to create their respective models  based on the Project 

Base Model settings and the Archi Model for the building layout 

   
 

 

Step 2: Link Models to Project Base Model 

a. Open the Project Base Model and link in required Models e.g. Archi and MEP, with 

Positioning -> Auto – Shared Coordinates. 

  
 

If done correctly, all the models when linked to the Project Base Model by Shared 

Coordinates should be aligned correctly. 
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6.0 MODELLING PLAN 

6.1 Dividing Project 
Modeling Plan is one which divides the project into manageable sizes to share among the 

team members. The example shown below is for the Architectural Model. 

 

  
Typical Unit(s) 

as 
Group 

Typical Floor(s) 
as 

Revit Link 

Apartment Block 
 

(Master File) 

Apartment Block 
as 

Revit Central File 

Local Copy 
for 

Team Member(s) 

 

Documentation 

 

R
ev

it
 W

o
rk

sh
ar

in
g 
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 Revit Groups are used mainly for repeating portions of the model. Groups helps to 

propagate changes quickly. Groups can be used for typical units and vertical shafts that 

may have one or more instances in the model. They should be used minimally. 

 

 Revit Links will improve the model performance. Thye are especially good for 

propagating changes when the project has typical floors. Links allow team members to 

share their work.  

 

 Worksharing allows multiple modellers to work on a single model and share updates 

quickly. Worksharing can be used during the preparation of the documentation by all the 

team members in a single model. 

 

6.2 Sharing of Files 
 It is recommended to share the Architectural Master and Link files with the Structural and 

MEP Engineers.  The Structural and MEP Engineers can use the information in the 

Architectural model to prepare their models/documentation. 

 

Note: 

These steps will be explained in the later chapter of the document. 

  

Architectural 
Model 

Structural 
Model 

MEP (Plumbing) 
Model  
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6.3 Revit Server 
 The next level of model sharing uses Revit Server. This is good for teams working remotely 

from different companies. Revit Server is a server application which  is the foundation for 

server-based worksharing for Revit projects. The Revit Server uses a central server and 

multiple local servers for optimal project collaboration across a wide area network (WAN). 

 

 The Revit Server consists of a single central server that connects with multiple local 

servers. 

 When a team member opens the server-based workshared project, he will be working in 

a local copy of the central model. This local copy, called the local model, is stored on the 

team member's computer. The central model is stored on the central server. 

 As a team member works, the local server silently requests updated information from the 

central model on the central server, using available network capacity to transfer data 

over the WAN. The updated version of the model is stored on the local server, so the 

updates are readily available when a team member requests them.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When the teams are working remotely, it is recommended some kind of  document 

management system is in place to share large files. This system should allow the team 

members to share files on the Internet. Most of these systems have good security features 

for controlling access to files. 

Central Server 
(Central Model) 

Team A Team B 

Local Computer 
(Local Model) 

Local Server(s) 
(Local Central Model) 

WAN 
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7.0 ARCHITECTURAL MODELLING 

7.1 Conceptual Design 
 Conceptual Design is the first stage in the design process. The design team will prepare 

various design options based on HDB’s design criteria and present them at the Progress 

Reviews (PR) and Management Reviews (MR). The design team can choose either one of 

the option described for the Conceptual Design.   

 

Deliverable: Design Concepts that consist of the schematic representation of blocks, storeys, 

units and their arrangements on site.  

 

Option 1: Use Revit to prepare the design options. This option is suitable for a design team 

which is familiar with Revit's conceptual design tools. The conceptual model can be used for 

further design development, which will save time in the next stage. 

Option 1 consists of Site Planning BIM model(s) for master plan site study and feasibility 

analysis. From this massing model(s), space areas and volumes can be extracted to check 

against HDB’s requirements and compare between design options. The number of massing 

models depends on the number of conceptual design options produced. Additional 

information may need to be added based on the design requirements. 

 

Option 2: Use non-BIM tools to prepare the design options. E.g. AutoCAD, Sketch-up. This 

option is recommended only if there are tight deadlines given for this stage, multiple design 

options that need to be prepared, or if the project is being carried out by a design team that 

may have just started using BIM. This option gives them necessary time to learn Revit before 

the next stage. 

 

 

 

  

Option 1 Option 2 
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 Step 1: Create the Massing Model 

The massing model can be created by following the steps below.  

a. Create a new project for the Massing Model and set up the coordinates, Project North, 

True North and Elevation Levels similar to the steps for creating an Archi Model under 

Section 5, Step 7 of this Guide. 

 

b. Open any one of the elevations and set the number of levels and floor to floor height as 

based on the design. 

E.g. 1st Storey level is 50mm higher from the platform,  

  1st Storey to 2nd Storey is 3600mm,  

  Typical Storey(s) height is 2800mm, 

  Main Roof Level to Water Tank Level is 2300mm, 

  Water Tank Level to Water Tank Roof Level is 2550mm and 

  Water Tank Roof Level to the Max Permissible Height is 800mm. 

  

 

 

 

 

 

 

 

 

 

 

 

c. It is recommended to prepare the massing model with the In-Place Mass tool individually 

for each unit and common area.  This allows the floor area to be extracted for individual 

units, which can be checked against the requirement. 

 
 

d. Open the 2nd Storey Plan view as the residential units start from the 2nd Storey. 

 

e. Activate the visibility of the Mass Form and Floors from Massing & Site tab   

Conceptual Mass panel  Show Mass Form and Floors. 
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f. Click In-Place Mass in Massing & Site tab  Conceptual Mass panel. 

 
 

g. Give a Name unique for the Unit type. e.g. Unit 3R.  

Revit enters sketch mode. Use the Sketch Tools available to create the Mass. 

 
 

h. Draw the foot print of the unit as per the design requirement. 

 
 

i. Switch to the 3D view window, select the sketch lines just drawn and click Solid Form 

from Modify | Lines tab  Form panel  Create Form. This will create an extrusion from 

the selected lines. 

 
 

j. Select the top surface of the solid just created. The surface can be pulled up by holding 

the handle highlighted in the image on the left. It is recommended to do this step from 

the elevation view so that we can adjust exactly to the height we need. 
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Click Finish Mass and switch to one of the elevations. 

 
Extend the extrusion up to the Main Roof Level by holding the handle.    

 

k. Repeat the Steps (e) to (i) for the rest of the unit types. 

 

l. Arrange the units as per the design option. 

 
 

m. Similarly create In-Place Mass for the common area. The common area consists of all the 

rooms for services, ducts, stairs, lifts, refuse bin centre and access balcony that connects 

the units with the rest of the areas in the building. The footprint of the common area 

starts from the 1st Storey (including the area below the residential units). It will be 

different from the 2nd Storey and Typical Storey. There will be a minimum 3 solid forms 

in the mass created for the common area. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

Common Area 

Common  

Area 
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Step 2: Create Mass Floors to Extract Floor Area/Mass  

a. Next create Mass Floors to extract floor area/mass. 

Select the Mass objects one by one. 

Click on Modify | Mass tab  Mass Floors. 

 

b. Select all the Levels shown in the dialog box.  

Click OK to complete the Mass floor. 

 
 

c. Create a schedule for the Mass Floor from the View tab  

 
 

 

 

 

 

 

 

d. Select Mass in the New Schedule dialog box that just appeared. 
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e. Add the fields highlighted in the image on the right. Do the necessary settings in the Filter 

and Formatting tabs and click OK to see the schedule similar to the one shown below.  

 
 

 

The key components for the conceptual design using BIM have been explained in the steps 

above. Prepare the rest of the contents as per the design requirements. Grids, Annotations 

and Sheets can be used to complete the task.  

 

Once a design option is selected, archive the contents and move on to the Preliminary 

Design stage. Use the contents of the selected design option as a base for the preliminary 

stage.  
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7.2 Preliminary Design 
 Preliminary design is the second stage in the process. In this stage the selected conceptual 

design option will be further developed into a proper BIM model using BIM elements like 

Wall, Column, Slab, Door, Window and other objects. Refer to HDB’s BEP Template for list of 

BIM elements that need to be modelled. Implement the modelling plan discussed earlier in 

this document. 

 Create link files for floors. e.g. Site, 1st Storey, 2nd Storey, Typical Storey and Roof.  

 Create typical units as groups inside the link files. 

 Create a Master File and set-up the necessary views for each block. 

 Create an overall Master File that links all the blocks together into the site.    

 

Refer to Appendix 4 for the steps on how to convert CAD drawings to BIM model when 

Option 2 (using non-BIM tools) is selected in Conceptual Design. 

 

Deliverables:  

 Architectural BIM model for design coordination with Structural and M&E Engineers 

 Architectural BIM model for URA Submission 

Please refer to Architectural BIM e-Submission guides for Specific Requirements of the 

Agencies. 

 

This chapter explains the steps on how to develop the Preliminary Design Model(s) from the 

Mass Model created in Conceptual Design (Option 1).  

 

a. The Site Model created in the Conceptual Design can be used as it is. 

b. The 1st Storey Model can be created by first duplicating the Mass Model project file. 

c. Choose the families and types to be used for the Floor, Column, Wall, Door, Window, CRC, 

Stairs and Lifts. If the families are not available then they will have to be created. 

Elements can be placed with approximate sizes and at approximate locations as there 

may not be enough information at this stage. 
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Step 1: Convert Mass Floors to Floors 

a. Convert the Mass floor of 1st Storey to Slab. Go to Massing & Site  Model by Face and 

click Floor. 

 
Select the Floor type from the type selector. 

 

b. Pick the mass floor of the 1st Storey and click create floor in Modify | Place Floor by Face 

tab. This will create the Slab for the entire floor. Create openings and fill with separate 

slabs for areas with level difference. Ex. Bath. 

 
 

c. Model the Columns, Walls, Doors and Windows. Add rooms like Pump Room, MDF Room, 

Bulky Refuse Room, Consumer Switch Room, Store, Refuse Bin Centre, Lift/Lift Lobby and 

Stairs. Home Tab  Room & Area Panel  Room 

 

d. Duplicate the Project Base File to create a Master File. Link the Site Model and the 1st 

Storey Model. 
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e. The 2nd Storey Model can be created by duplicating the Mass Model project file. Edit the 

Mass Model, reduce the extrusion height of the 3rd Storey as shown below. Preserve 

Level 2 and Level 3 and remove the rest of the levels. This is to avoid confusion when the 

model is linked to the Master File.   

 
 

f. Choose the families and types for the Slab, Column, Wall, Door, Window, CRC, Stairs and 

Lifts. If these families are not available, they will have to be created. Elements can be 

placed with approximate sizes and at approximate locations as there may not be enough 

information at this stage. 

 
 

g. Convert the Mass floor of typical unit mass to Slab. Go to Massing & Site  Model by 

Face and click Floor. 

 
Select the Floor type from the type selector.  
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h. Pick the mass floor of the typical unit and click create floor in Modify | Place Floor by 

Face tab. This will create the Slab for the entire unit.  

 
 

 

Step 2: Convert Mass Walls to Walls 

a. Convert the external face(s) of the typical unit mass to Wall(s). Go to Massing & Site  

Model by Face and click Wall. 

 
 

b. Select the Wall type from the type selector and Location Line from the Option panel. 

 
 

c. Pick the desired vertical face of the typical unit mass. This will create the wall attached to 

that face. These walls will form the External facade and common walls of the unit. 

 

 

Step 3: Create the Unit Layout 

a. Model columns and walls to create the unit layout. Place doors, windows and other 

objects necessary at this stage. Create different slabs for areas with differences in levels 

(e.g. Bath/WC) or thickness (e.g. Household Shelters).  

 

b. Select the unit and make it as a group. Repeat this for the rest of the typical units. These 

units can be un-grouped when the unit design is confirmed to reduce the file size.     
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c. Place the Units (Groups) in the plan, add the rest of the Slabs, Columns, and Walls in the 

common area and complete the 2nd Storey Model. Link to the Master File created in Step 

1(a). 

 

d. Create Ramps  at required areas (e.g. Entrance to the Units, Entrance to the Bath/WC etc) 

This can be done by editing the slab. Select the Slab, Go to Modify | Floors tab  Shape 

Editing Panel and Click on Modify Sub Elements. Click on the node that needs to be 

changed in the slab profile and set the elevation as required. 

 
 

e. Doors of the service ducts should be 100mm above the finished floor level of the Access 

Balcony. Set the Sill Height parameter of the doors to 50mm as the floor level of the 

Access Balcony is already -50mm.  

 
 

 

Step 4: Create the Typical Storey Model & Roof Model 

b. Duplicate the 2nd Storey Model file to create the Typical Storey Model. Move the 

contents of the duplicated model to the 3rd Storey (BCA-_FP_3rd Storey Plan View). 

Make the necessary changes to the layout and Link to the Master File created in step 3.d. 

Copy the link to the rest of the Typical Floors, by Copy to Clipboard and Paste Aligned to 

Selected Levels, until the level below the top most Residential Level. 

 

c. Duplicate the Typical Storey Model and create the Roof Model that contains the top most 

Residential Level, Main Roof Level and Water Tank Level. Some key items to be 

modelled:  

 Water Tanks, 

 Access Platforms, 

 Lift Motor Rooms, 

 Slab thickening for House Hold Shelter and 

 Vents for the service duct coming from the units.  

 

d. Complete the Roof Model and link to the Master File created in Step 1(a). 
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e. Add the basic dimensions in the Master File, clean up the Plans and Elevations. As part of 

the documentation, prepare the 1:100 scale Plan, Elevations and Sections. The model is 

ready for the next stage. 

 

Note: 

The model at this stage should be sufficient for URA submission. Please refer to Architectural 

BIM e-Submission Guideline for detail requirements. 

  

 
 

Note:   

A clean-up is required for the links. In the clean-up, user need to hide the Grids and Levels 

that comes from the link files and reveal the visibility of correct floors in the levels. E.g. 

Display only the 1st Storey model and hide the rest of the links in the 1st Storey plan view. 

 

f. All these can be done in the Visibility/Graphics  Revit Link Panel. Type VG to activate 

the Visibility/Graphics dialog box. 

 
 

g. Share the Preliminary Design model with the Engineers to prepare their part of the 

model. 
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7.3 Detailed Design 
 Detailed Design is the third stage in the process. In this stage the Preliminary Design model 

will be further developed with more accurate BIM elements based on the feedback from the 

other disciplines and Technical Departments. Additional BIM elements need to be added to 

complete the model as well. Refer to HDB’s BEP Template for list of BIM elements that need 

to be modelled. 

 

Examples of the additional elements were given below and highlighted on the model (right) 

 Railing for Aircon ledge,  

 Clothes Drying Racks 

 Canopies with the connecting Beam, 

 Railing on the parapet walls and 

 Handrail along the Access Balcony 

 

 

 

 

Deliverables:  

 Architectural BIM model for Tender with drawings highlighted in the next section 

 Architectural BIM model for Regulatory Approvals 

Please refer to Architectural BIM e-Submission guides for Specific Requirements of the 

Agencies. 
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2D information can be used to complement the BIM model to improve the detail of the 

model. e.g. Hatch patterns can be used to represent the Tile Finishes either in the 2D views 

or as part of the material. 

 

The following are usually additional documentation to be done in this stage:  

 1:50 scale Layout Plans and Sections of key areas like the Typical Unit, Lift Lobby and 

Central Refuse Chute. 

 1:50 scale Finishes Plans and Sections for the Typical Unit, Lift Lobby, Central Refuse 

Chute, Bath and Kitchen. 

 1:50 scale Ceiling Plan for the Lift Lobby if required by the design specification. 

 

Note:  

It is not necessary to produce the entire set of documentation from the BIM model. 2D detail 

drawings (e.g. extrusion of window frame) could be used to supplement the drawings from 

the BIM model.  

 

The following are some of the drawings to be produced from the model in the Detailed 

Design stage: 

DRAWINGS SCALE 

1. LAYOUT & KEY PLAN 1:500 
2. 1ST STOREY FLOOR PLAN 1:100 
3. 2ND STOREY FLOOR PLAN 1:100 
4. TYPICAL FLOOR PLAN 1:100 
5. MAIN ROOF PLAN 1:100 
6. FLOOR PLAN OF WATER TANK & PUMP ROOM 1:100 
7. ROOF PLAN OF LIFT WELL & STAIRCASE 1:100 
8. ELEVATIONS 1:100 
9. SECTIONS 1:100 
10. TYPICAL UNIT PLANS 1:50 
11. PLANS OF LIFT LOBBY & STAIRCASE 1:50 
12. TYPICAL UNIT FINISHES LAYOUT 1:50 
13. FINISHES LAYOUT OF LIFT LOBBY, CENTRALISED REFUSE 

CHAMBER & WASH AREA 
1:50 

14. ELEVATIONS OF KITCHEN & BATH/WC 1:50 
15. ELEVATIONS OF LIFT LOBBY, CENTRALISED REFUSE CHAMBER 

AND REFUSE CHUTE AT WASH AREA 
1:50 

16. REFLECTED CEILING PLANS OF LIFT LOBBY 1:50 
17. TYPICAL PLANS OF HOUSEHOLD SHELTER 1:50 
18. SECTIONS OF HOUSEHOLD SHELTER & STOREY SHELTER 1:50 

 

Additional drawings may need to be produced, depending on the requirements of the 

 project. 
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Step 1: Create a Floor Plan 

a. A sample of a 1st Storey Floor Plan is shown below. 

 

 

Add the following annotations to the plan view: 

 Grid dimensions; 

 Setting out for the Room(s); 

 Indication of Room Name(s); 

 Indication of Finishes and Fall; 

 Annotations of Typical Elements; 

 Door and Window tags; 

 Section line marking; 

 Elevation markings; and 

 Indication of surface drains  
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Step 2: Create a Typical Floor Plan 

a. A Sample of a 2nd Storey Plan is shown below. Typical Floor Plan(s) will look similar to 

this. 

 
 

Add the following annotations to the plan view: 

 Grid dimensions 

 Setting out for Typical Unit(s). It is not necessary to repeat the setting out for 

similar/mirrored units. Indications should be made, referring to the unit that has the 

setting out. 

 
 

 Setting out for the Common Area  

 Indication of Room Name(s); 

 Indication of finishes and Fall; 

 Annotations of Typical Elements; 

 Door and Window tags; 

 Section line marking; and 

 Elevation markings   
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Step 3: Create a Roof Plan 

a. A sample of a Roof Plan is shown below. (Annotations are similar to the Floor Plans 

mentioned earlier.) 

 
 

 

Step 4: Annotate the Elevation 

a. A sample of an Elevation is shown below. 

 
Add the following annotations to the elevation view: 

 Grid dimensions; 

 Floor to Floor height; 

 Indication of levels; and 

 Annotations of Typical Elements  
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Step 5: Annotate the Section 

a. A sample of a Section is shown below. 

 
Add the following annotations to the section view: 

 Grid dimensions; 

 Floor to Floor height; 

 Indication of levels; 

 Height indication of Typical Areas; and 

 Annotations of Typical Elements 

 

 

Step 6: Create a Typical Unit Plan 

a. A sample of 1:50 a Typical Unit Plan is shown below. 

 
Add the following annotations: 

 Grid dimensions; 

 Setting out of Room(s); 

 Indication of Room Name; 

 Indication of finishes; 

 Annotations of Typical Elements; and 

 Indication of Furniture/Fittings   
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Step 7: Create a Typical Unit Finishes Layout 

a. A sample of 1:50 a Typical Unit Finishes Layout is shown below. 

 

 
Add the following annotations: 

 Indication of the tiles using Fill pattern. Room(s) 300 X 300 and Bath/WC 200 X 200; 

 Annotate the finishes 

 

 

Step 8: Create 1:50 Drawings of Lift Lobby and Refuse Chute Areas  

a. Samples of 1:50 drawings (1st Storey and 2nd Storey) of Lift Lobby and Refuse Chute 

areas are shown below. 
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Step 9: Create 1:50 Finishes Drawings of Lift Lobby and Refuse Chute Areas  

a. Samples of 1:50 Finishes drawings (1st Storey and 2nd Storey) of Lift Lobby and Refuse 

Chute areas are shown below. 

 

 

 

Step 10: Create 1:50 Elevations of Kitchen and Bath/WC 

a. Samples of 1:50 Elevations of Kitchen and Bath/WC are shown below. 
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Step 11: Create Sheets and Publish for Submission 

a. Once the views are ready, create the Sheets, drag the views into the sheets and complete 

the documentation process. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

b. Publishing Model and Drawings to Non-editable File Format 

Refer to Appendix C of Architectural BIM e-Submission Guideline for step-by-step guide 

to export/ publish to DWF/PDF for regulatory submission. 

 

Note: 

The drawings produced from the BIM model during the Detailed Design stage can form 

part of the tender documents together with other 2D detail drawings.  
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8.0 STRUCTURAL MODELLING 

8.1 Preliminary Design 
The preliminary Structural BIM Model could be created from the Architectural BIM Model. 

The Grids, Levels, Slabs, Columns and Structural Walls could be copied from the Architectural 

Model to create the base Structural Model, while the Beams (Structural Framing) need to be 

added to complete the Structural BIM Model. Refer to HDB’s BEP Template for list of BIM 

elements that need to be modelled. 

 

Note:  

It is not necessary for the elements to be modelled as Precast Elements. 

 

Deliverables:  

 Structural BIM model for design coordination with the Architect and M&E Engineer. 

 

The Structural BIM model can be created in the following ways, depending on the 

Design/Analysis tool to be used: 

a. Using the Structural BIM authoring tool, before being transferred to the Design/Analysis 

tool to perform Design/Analysis; 

b. Using the Design/Analysis tool, before being transferred back to the Structural BIM 

authoring tool. 

 

Note:  

Some of the design analysis tools support the transfer of data bi-directionally. 

 

 

Step 1: Create a New Project 

a. Create a new project from the Project Template. From the Application Menu choose 

New  Project. 

 
 

b. In the New Project dialog box choose Project in the Create new section. 
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c. Click the Browse... button and locate the template file using the file dialog box.

 
 

d. Click OK to create the new project. 

 

 

Step 2: Link the Architectural Model 

a. The new project created in Step 1 is shown in the image below. Link the Architectural 

BIM Model and copy the settings and content necessary for the Structural BIM Model. 

 
 

b. From the Insert Tab choose Link Revit. 

 
 

Note:  

It is good to link the individual storeys one by one rather than the entire block (Master 

File). This will be helpful later when using the Copy/Monitor tool to copy the Architectural 

elements. 
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c. Select the Architectural BIM Model using the file dialog box. Choose Origin to Origin for 

the Positioning and click Open. 

 

d. After the Architectural model is linked, the content may not be visible. It is necessary to 

copy settings like Shared Co-ordinates, Levels, Grids and Visibility. 

 

 

Step 3: Copy Shared Coordinates, Levels, Grids and Visibility 

a. Copy the shared co-ordinate settings from the Architectural Model. Switch to one of the 

Elevation and Zoom extent. The levels of the Structural BIM Model and Architectural BIM 

Model may not be in the same place. 

 

b. Refer to Section 5.4 of this Guide on how to Acquire Coordinates from the Project Base 

Model and change the Elevation Levels. 

 
 

c. Create or delete levels depending on the project requirements. 

Create Additional Level for Pile Layout Plan view. 

Rename the newly created levels. 

 

Check whether there are plan views for 1st Storey, 2nd Storey, Typical Storey, Main Roof 

Level, Water Tank Level and Water Tank Roof Level. If it is not there then Create plan 

views (the menu is in View tab) for the missing levels and rename them as per the 

standard. 

 

  



 

  79 

d. Link/associate the levels to the Architectural BIM model to make sure that changes to the 

levels in the Architectural BIM model's level are reflected. This can be done using the tool 

Copy/Monitor in the Collaborate tab.  

 

Note:  

This needs to be done in an elevation view. 

 

Go to Copy/Monitor tool and choose Select Link. Pick the Architectural model just linked 

in the previous steps. This will open up a specific tab for Copy/Monitor. 

 

Choose the Monitor tool, pick the 1st Storey level and pick the 1st Storey level of the 

Architectural BIM model. This will link the levels together and a Monitor icon will appear. 

Repeat this for the rest of the levels and click Finish. From now on any changes in the 

Architectural levels will be highlighted. 

 

e. Copy and monitor the grids from the Architectural Model. 

 

f. Switch to the 1st Storey plan view. 

 

g. To show the corresponding Architectural plan, Right click on the view in the Project 

Browser. Duplicate the view and Type VG to activate the Visibility/Graphics dialog box. 

 

Choose the Revit Links tab, make sure the Architectural Model link is selected in the 

Visibility. Click on the Custom button under Display Settings. This will activate the RVT 

Link Display Settings dialog box. 
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Choose Custom radio button in the Basics tab. Choose the corresponding view in the 

Linked view and click Apply twice. This will display the correct plan. 

To see all Architectural elements, change the Discipline parameter in the View's 

Properties palette either to Architecture or Coordination. 

 

Repeat this for the rest of the views. 

 

h. Choose Copy/Monitor again. This time choose the Copy tool as there are no existing grids 

in the plan. 

 

Choose Multiple in the options bar, select all grids, click Finish(1) in the options bar and 

then Finish(2) in the Copy/Monitor tab. 

The grids will be created and associated to the Architectural grids and a Monitor icon will 

appear. From now on any changes in the Architectural grids will be highlighted. 

 

 

Step 4: Copy Structural Elements from the Architectural Model 

a. Switch to 3D view, Duplicate and do the necessary visibility settings for the Coordination 

view (similar to steps done in the plan view). 

 

b. Choose Copy/Monitor again, choose the Options in the tab to set the correct family type 

mapping for Columns, Walls and Floors. The Original type refers to the family and type 

from the Architectural Model, while the New type refers to the family and type that is 

going to be created. If the family is not found, it is recommended to create the family 

before carrying out this step.  

In the options dialog box there may be an option Copy Original Type. This allows the user 

to create a New type from the Original type.  

 

Note: 

If this option is used, there will be some redundant types of families that need to be 

cleaned up.  
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Note:  

Choose “Don't Copy This Type” for families/types that are not required in the project. 

 

c. After the options are set correctly, Choose the Copy tool. 

 

d. Choose Multiple in the Options bar, and select all the columns, structural walls and slabs 

in the link. Click Finish (1) in the options bar and then Finish (2) in the Copy/Monitor tab. 

This will create the equivalent elements and associate them to the Architectural Model. 

 

e. Repeat Steps 4(b) to (d) for the rest of the floors.  

 

f. Add the Beams with approximate size for each floor. After the model is completed it is 

ready to be exported into Design/Analysis tools. 
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g. Alternatively, use the Design/Analysis tool to determine the size and design of the 

members, and produce the member detail drawings from the design tool.  
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h. Update the Structural BIM model with the member sizes and markings generated from 

the Design/Analysis tool. A sample is shown below. 

 

 

 

The plans generated from the Design/Analysis tool shows the location of the beam. A 

part of the plan is shown below.  
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The Column sizes and markings can be obtained from the plans generated from the 

Design/Analysis tool. 

 

 

 

i. Once the model is completed, the model can be shared with other disciplines for design 

coordination. 
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8.2 Detailed Design 
In the Detailed Design stage, the Preliminary Design model will be further developed with 

more accurate BIM elements. Additional BIM elements need to be added to complete the 

model as well. Refer to HDB’s BEP Template for a list of typical BIM elements that need to 

be modelled. 

Some examples of the additional elements are listed below. 

 Stairs (not the complete detail), 

 Precast parapet for the details  

 Piles and Pile caps 

   
 

Deliverables:  

 Structural BIM model for Tender with drawings highlighted in the next section. 

 Structural BIM model for Regulatory Approval  

Please refer to Structural BIM e-Submission guides for Specific Requirements of the 

Agencies 

 

2D information can be used to complement the BIM model to improve the detail of the 

model. Ex. Detail lines can be drawn to represent the Rebar in a section cut from the BIM 

model. 

 

 
Note: 

Column Schedule, Beam Schedule, Member Details and Reinforcement arrangement plans 

can be produced from the Design/Analysis tools as 2D DWG/DXF and inserted into the BIM 

model file. 
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The following are some of the drawings to be produced from the model in the Detailed 

Design stage: 

DRAWINGS SCALE 

1. PILING LAYOUT PLAN 1:100 
2. 1ST STOREY GENERAL ARRANGEMENT PLAN 1:100 
3. 2ND STOREY GENERAL ARRANGEMENT PLAN 1:100 
4. TYPICAL FLOOR GENERAL ARRANGEMENT PLAN 1:100 
5. MAIN ROOF GENERAL ARRANGEMENT PLAN 1:100 
6. GENERAL ARRANGEMENT PLAN OF WATER TANK & PUMP 

ROOM 
1:100 

7. GENERAL ARRANGEMENT PLAN OF LIFT WELL & STAIRCASE 
ROOF 

1:100 

8. ELEVATIONS 1:100 
9. SECTIONS 1:100 
10. TYPICAL DETAIL SECTIONS (ACCROSS THE BUILDING IN 

SELECTED LOCATIONS) 
VARIES 

Additional drawings may need to be produced, depending on the requirements of the 

project. 

 

Step 1: Create a Pile Layout Plan 

a. A sample of a Pile Layout Plan is shown below. 

 
Add the following annotations to the plan view: 

 Grid dimensions; 

 Markings; 

 Size; 

 Load; 

 Setting outs and 

 Zones 
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Step 2: Create a 1st Storey General Arrangement Plan 

a. A sample of a 1st Storey General Arrangement Plan is shown below. 

 

 

Add the following annotations to the plan view: 

 Grid dimensions; 

 Markings; and 

 Size   



 

  88 

Step 3: Create a Roof General Arrangement Plan 

a. A sample of a Roof General Arrangement Plan is shown below. 

 

 
 

Add the following annotations to the plan view: 

 Grid dimensions; 

 Markings; and 

 Size 

 

Additional indication of Slab thickening above the House Hold Shelter is shown with a 

hatch pattern. 
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Step 4: Create a Water Tank General Arrangement Plan 

a. A sample of a Water Tank General Arrangement Plan is shown below. 

 

 

Add the following annotations to the plan view: 

 Grid dimensions; 

 Markings; and 

 Size  

 

 

Step 5: Create Details 

a. Samples of some Details are shown below. 

 

 
Add the following annotations: 

 Dimensions; 

 Member Markings;  

 Rebar Annotations; and 

 Slopes  
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Step 6: Create Sheets and Publish for Submission 

a. After the views are ready create the Sheets, drag the views into the sheets and complete 

the documentation process. 

 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

b. Publishing Model and Drawings to Non-editable File Format 

Refer to Structural BIM e-Submission Guideline for step-by-step guide to export/ publish 

to DWF/PDF for regulatory submission. 

 

Note: 

The drawings produced from the BIM model during the Detailed Design stage can form 

part of the tender documents together with other 2D detail drawings.  
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9.0 MECHANICAL & PLUMBING MODELLING 
This chapter on BIM Modelling for Mechanical and Plumbing covers the Water and Sanitary 

services. The concept for the rest of the M&E services is similar. 

 

 

9.1 Conceptual Design 
Conceptual Design for Mechanical and Plumbing covers basically the steps required for 

creating the Schematics. BIM modelling is not required. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Schematics 

Objective: Create a single line diagram that shows the distribution of the system into the 

HDB block. 

 

Deliverable: Schematic Diagrams 

 

Procedures: 

BIM authoring tools do not have the capability to generate schematic diagram automatically 

from the model at this moment. It is recommended to follow either one of the options 

below to generate Schematic Diagrams.  

 Schematic Diagram using traditional 2D method in AutoCAD 

 Schematic Diagram using BIM tool 

 

  



 

  92 

Schematic Diagram using Traditional 2D Method in AutoCAD Application 

Schematics created in AutoCAD can be loaded directly to Revit through the following steps: 

 

a. Create a new Sheet from the View Tab of Revit. 

View  Sheet 

 
 

b. Select the title block based on the system from the list of the title blocks shown in the 

New Sheet dialog box. 

 

c. The created new sheet for the schematic diagram will be placed under the non-category 

(???) views on the project browser.  Right click on the created sheet and rename it based 

on the  BIM e-Submission requirements. 

 
 

 

d. Insert the pre-created 2D CAD drawing through Insert tab  Link CAD then choose the 

intended file as shown in the image below. 
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Schematic Diagram using BIM Tool 

It is advisable to import the symbols and typical details that already created in CAD. This is to 

save time in creating the schematic diagram. Below steps are need to follow to finish the 

schematics. 

 

a. Create a new Sheet from the View Tab. 

View  Sheet 

 

Note: 

Drafting view can be used to create the schematic as well. 

 

b. Select the Mechanical Building drawing from the list of the title blocks of the template. 

Import the 2D symbols through Insert Tab  Import CAD (a and b from the figure below) 

 
 

c. Place the imported 2D symbols into the drawing and connect it using the Detail Lines. 

Use Annotate (c) Tab Detail Line (d) tool to draw the Detail Lines. The steps to draw 

the Detail Lines are similar to creating lines in AutoCAD. 

 

d. Select the created lines (e) (shown in image below) and change the Line Style properties 

to its representing system (f).  
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A Sample Schematic Diagram created using 2D lines and Texts is shown below. 
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9.2 Preliminary Design 
The preliminary Mechanical and Plumbing (M&P) BIM Model could be created from the 

Architectural BIM Model and serves as a preparation for the Detailed Design stage. 

 

Before starting the actual modelling, it is recommended to go through proper planning and 

preparation. 

 

Recommended Workflow  

Below is the graphical sequence of connected steps to be carried throughout the 

development of the model.  

 

 
 

It is recommended to divide the project into different files for different services in order to 

manage file size and to delegate the task to the team members. After completion of each 

service, the models can then be linked together for services coordination. 
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Understanding the MEP BIM e-Submission Template  

The template files provide initial conditions to a project. A new project inherits all settings, 

families and title blocks from the template file.  

 

Settings 

 The Project Browser of the template is organised by the different Regulatory Agencies.  

 The views were enabled with Visibility GraphicsFilter (by System) as shown below.  

 

s 
 

Visibility Graphics (VG): 

 This is set to manage graphical display of the elements in the view. 

 Systems that are not necessary in the view were properly turned off. 

 Colours for the system are as per CP83 Standard. 

 The modellers can go directly to the views specific for each agency/service/system and 

start the modelling. 
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Families and Groups 

The default families available inside the template can be used for the modelling. Additional 

objects can be downloaded from the web and loaded into the project through Insert tab of 

Revit. Objects downloaded from the web should be tested for suitability and correctness 

before use.  

 

In addition, some groups of interconnected families as shown in the figure below can be 

created inside the template. These pre-loaded objects can be placed as one and adjusted to 

suit the project requirements. 

 

Note: 

Create separate groups for families that need to be mirrored instead of mirroring the same 

group as the connections (hot and cold water) location will be mirrored as well. 
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Title Block 

Template comes with the standard title block as shown below, customise it as a company 

standard title block with HDB’s requirements incorporated. 

 

 
Standard Title Block 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Customised Company Standard Title Block   
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Project Setup 

Files needed: Architectural Model and the Project template. 

 

Step 1: Loading the Project Template 

 

 

a. From the Application Menu , click on the Options button.  

 

b. Under the File Location, browse for the Project template. Click OK once done. 

 

c. Click on New Project to start. 
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Architectural Model Validation 

The basic elements required from the Architectural BIM Model for the M&P BIM model are 

as listed: 

 Plumbing Fixtures  

 Water tanks 

 Ceiling 

 Floors 

 Riser’s location 

 Inspection Chamber 

 Grids 

 Levels 

 

The elements, especially MEP fixtures, should be placed realistically on the architectural plan 

for proper modelling of required MEP systems. 

 

 

Step 2: Linking Architectural Model 

Refer to Section 3.1 for the basic elements required from the Architectural BIM Model for 

the M&P BIM model. The elements, especially MEP fixtures, should be placed realistically on 

the architectural plan for proper modelling of required MEP systems. 

 

a. Go to Insert Tab and choose Link Revit 

 

Note: 

It is good to link the individual storeys one by one rather than the entire block (Master 

File). This is to manage the file size and prevent system lag during modeling process. 

Combining the M&P model can be done once typical floor is completed. The steps will be 

discussed in the later chapter. 

 

b. Link the model using Origin to Origin Positioning in order to place in the same position as 

Architectural model.    
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Note:  

If the Central Architecture Model will be used, all nested links must be set as OVERLAY in 

the Reference Type under Manage Links dialog box. This is to properly see the model in 

your working window. 

 

 

Step 3: Adjusting MEP Levels and Creating Grids 

Adjusting MEP Levels with the Architectural Model  

 

a. On the project browser, open one of the Elevation views. 

b. In the Elevation view, click the Align tool  under the Modify tab. 

 

c. Select the Level of the linked architecture model, (a in the left figure) then select the MEP 

Level that intended to move (b). Grid will be aligned accordingly.  

Repeat for the rest of the levels and rename them if necessary.   
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Step 4: Copying and Monitoring Project Gridlines 

Copying and monitoring the project gridlines is the one of the best practices in modelling 

services of the project. The grids would be updated to reflect the changes made in the 

Architectural BIM model. 

 

a. From the Collaborate Tab, click Copy/Monitor Tool then choose Select Link from the 2 

given options.  

 
 

b. Select the linked architecture model.  

 

c. Select Copy tool from the ribbon (a) from below figure and click the Grids in the linked 

model (b). 
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Creating Base File for MEP Services 

a. The separate project base file should be created for MEP services and used to model 

different portions of the project. This allows linking the individual portions of the model 

smoothly to the central file that shows the complete assembly of the project. 

Copy the project file that was set based on the number of services to be modelled. 

 

 

Preliminary Design Modelling 

a. Create a copy of the Project Base File discussed in the previous item. Copy the fittings 

from the Architectural Model and model only the main distributions of the project. 

 

b. Choose the families/types for the MEP components. Components can be placed with 

approximate sizes and in approximate location as there may not be enough information 

at this stage. Refer to HDB’s BEP Template for the list of BIM elements to be modelled by 

the MEP discipline. Users shall follow a standard naming convention. 

 

c. Share the Preliminary Design model with the Design Team for co-ordination.   
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9.3 Detailed Design 
In the Detailed Design stage, the Preliminary Design model will be further developed with 

more accurate BIM elements, based on feedbacks from the Technical Departments and 

other disciplines. Additional BIM elements need to be added to complete the model as well. 

Refer to HDB’s BEP Template for a list of typical BIM elements that need to be modelled. 

Elements should be with an accurate dimensions, shape and location. Non-geometric 

properties should be provided.  

 

Deliverables:  

a. Tender BIM Model with drawings 

Content: 

 Layout and Key Plans 

 Site Plans 

 Floor Plans 

 

b. Submission BIM Model for Regulatory Approval  

Please refer to MEP BIM e-Submission guides for Specific Requirements of the Agencies 

 

This sub-chapter will be divided into different services namely: 

 Water and Gas Services 

 Sanitary Service and 

 Electrical Service 

 

 

  



 

  106 

1. Modelling Water and Gas Services 

After the project has been set up, the water and gas services can be modelled in the 

manner illustrated below. 

 

 

 

 

 

 

  

Typical Unit 
 

Placing Plumbing 

Equipment and 

Fixtures 

Modelling the 

Systems 
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Step 1: Model Plumbing Fixtures 

Open the base file that was created for Water and Gas services.    

 

a. Choose Wash Basin Assembly from the list of preloaded assemblies in the template 

(letter a from the figure below) and copy (b) 

 

b. Pick the start point of copying. (c)  

 

c. Place the copied assembly to the same position of the fixtures of the architectural model. 

(d) 

 

d. Parts of the groups should be adjusted if necessary to fit the required clearances.  

 
 

e. Load other plumbing fixtures from the library folder if necessary and do the above steps.  

 

f. After the above step is done, the model will look like the image below. 

 
 

Note:  

In detail design stage, elements should be placed into the ideal position. Therefore, 

offset or level of the elements with reference to the finish floor level is one of the 

factors should be considered in modelling. 
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Step 2: Model Connections 

When all plumbing fixtures necessary for the water and gas services of the unit were placed, 

modelling connections with piping will then be the next. In modelling piping systems, below 

are the settings to be considered: 

 Pipe Materials 

 Pipe System 

 Size (please refer to HDB standard pipe sizes) 

 Level or Offset from finish floor level 

 

The following steps will lead the modellers to get this done. 

a. Choose pipe tool from the Home tab of Revit. ( Letter a & b from figure below) 

b. Select the type of pipe to be used from the Property tab of Revit. (c) 

c. Choose the required diameter of the pipe for the pipe specified. (d) 

d. Set the required offset from the finish floor level of the model. (e) 

 

 
 

Model and place the pipe into its ideal location. The modeller should verify the design 

whether the pipe should be embedded or exposed to the wall. 

 

  
Plan View    3D View 
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Step 3: Connect Water Fixtures with Pipe System 

It is advisable not to create all elements in one view (e.g. plans) as some elements are much 

easier to model and connect properly in other views (e.g. elevations and sections). 

 

In the following steps, the pipe will be connected to the wash basin in section view. 

 

a. Cut a section into the floor plan.  

View tab  Section.  

 
 

b. Draw a section line from point a to point b, as shown in the figure below. 

 

c. Once the section is created, right click on it and choose Go to View. (c) The Section 

created will be displayed. 

 

   
 

d. On the Section View, select the elbow fitting and select the Connect Into ( ) tool 

on Modify tab of Revit. 

 

e. Then choose the overhead pipe to connect. 

 

f. Repeat the above steps to connect the other fixtures. 
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Connecting Pipe Directly to the Fixtures 

Before the pipe is connected to a particular plumbing fixture, there should be a basic 

understanding of the properties of the fixture or equipment. . The properties of components 

may vary based on the category. The wash basin is used as an example here. 

 

 

Figure taken from family editing window 

 

Where: 

a = point of connection 

b = direction of the pipe to be connected 

c = name and the system property ( ex. Cold water, hot water, etc. ) 

d = dimension of the connection port 

 

Note: 

Warning might appear during modelling due the above properties. 

 

The steps below can be applied to the fixture or equipment that is not connected to any 

system yet. 

 

a. Cut sections in the model showing the connection 

point of the fixtures and the preferred route of the 

pipe.  

 

b. Select the fixtures, Revit will show you the different 

connection points of the fixture. Pick the system (a 

from the left figure) to be created and move the 

mouse to the preferred route. (b & c) On the other 

hand, right click to the connection point and choose 

Draw pipe.  

 

c. Repeat the above steps for the other fixtures if necessary.  
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Modifying Groups 

Group of interconnected families that are pre-loaded could be modified in order to suit the 

design requirements.  

 

Below are the steps to get this done. 

 

On the example below, the pipe connection will be changed from back direction to side. 

(back direction) 

a. Select the group and click Ungroup from the Modify tab. (a & b from the left figure) 

Select and edit each element from group. 

 

b. Choose a convenient view to select the elbows together with the pipes that need to be 

re-routed. Press Delete key on the keyboard. 

 

c. Select the pipe and right click to its end point (c) and choose draw pipe from the options. 

Move the mouse to the prefer direction. (d) 

 

 
Re-routed Pipe (side direction) 

 

Modelling tip: 

Risers and other vertical parts of the system are much easier to create in section or 

elevation view of the model. 
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The completed water system is shown below. 

 

The unit can then be mirrored or copied to complete the whole floor.  

 

Now the model is ready for documentation. 
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2. Modelling Sanitary System 

The settings listed below should be considered when modeling the sanitary system of a 

residential block. References should be made to the prevailing  statutory regulations and 

HDB standards: 

 Pipe Materials and Fitting to be used in the systems 

 Pipe System 

 Size 

 Level or Offset from finish floor level 

 Slope 

 

Recommended fittings for the sanitary system in a HDB residential block: 

 

     
Floor Trap for toilet   P-Trap for kitchen area 
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Recommended Workflow for modelling Sanitary System of a HDB residential block: 

 

 

 

 

 

 

 

 

 

 

  

Typical Unit 
 

Modelling Risers, Groups and Fixtures 
 

Modelling Sanitary Service 

through pipe connections 
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Step 1: Model Main and Secondary Discharge Stack 

Modelling the risers for Main Discharge Stack (MDS) and Secondary Discharge Stack (SDS) 

can be modelled with the following steps.   

 

a. Extend the Plumbing Category on the project browser and double click PUB-

SANITARY_FP_2ND STOREY. 

 

b. Create a group for the Vertical Discharge Stack. 

Select the Group  Modify tab, Copy  

 

c. Pick the center of the MDS pipe as a Start point of placing ( a from the figure below) and 

put it at the center of the circle mark ( b )  provided in the architectural model. Please 

refer to the below figure. 

  

 

Modelling Tips:  

To get a perfect center snapping, while moving the element to the intended location, 

right click on the reference point and choose Center. When the center of the circle is 

highlighted, click once more. 
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Step 2: Model Floor Traps 

Floor traps and floor drains cannot be placed without the hosting elements such as floors or 

slab. Placing of these elements in the model can be done through following the steps below. 

a. From the Home tab, (a from the left figure) choose Plumbing Fixtures. (b) 

 

b. From the Property panel, pick the required floor trap type in the project. (c) 

 

c. Choose the Place on Face as a placement method.  (d) 

Once placement method has been set, move the cursor and Click into desire place. 

  
 

  
 

When all the required plumbing fixtures were placed, the model will look like figure 

below. The plumbing fixtures can now be connected by the piping system. 

 

 

Model showing the modelled layout of the HDB typical bathroom. 
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Step 3: Model Sanitary Pipe System 

Note: 

The slope of the pipe should be considered in modelling the sanitary system. The View 

Range could be modified to see all the elements into their model.   

 

a. Go to the Floor Plan view of the model by double clicking on the Project Browser. 

 

b. Open the View Range setting from the Property Box  

 

c. Adjust the View Range of the model view and assign negatives values into the Bottom 

and View Depth; Level. Please refer to the below figure.  

Click OK once done. 

 
  

 
This will allow the modellers to see and pick the elements below the slabs. 

 

Modelling Tip:  

Model in the Wireframe visual style will allow each component of the model to be 

picked and connected easily. 

 

Start the pipe modelling at the furthest fixture from the riser so that the clearance and 

slope of the pipe can be easily controlled. 

 

d. Cut and open a section with the furthest fixtures on the toilet layout. 
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e. Select it and click the System Icon ( ) and draw a pipe moving from the bottom of 

the water closet. See the figure below. Stop at point a and assign the slope of the pipe (b) 

and move the cursor to the left going to MDS direction. (c) 

 

f. Repeat the same steps until all the water closets are connected to the Riser. 

 
 

 

Step 4: Connect Floor Trap 

a. Cut a section in the floor plan showing the floor trap. 

 
 

b. Create a down pipe as shown in the below figure. This step is the same as the procedure 

of connecting the water closet. 

 

c. Stop at point a then attach the S –trap. The S-trap family can be loaded by selecting it 

from the list in the Property Panel of the Home tab  Pipe Fitting (b). Once the S-Trap 

had been placed, adjust if necessary to fit the required overhead clearance. 
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d. Finally, connect the S-trap to the nearby horizontal pipe. (c) See below figure after all the 

steps have been done. 

 

 
 

e. Repeat the steps until the rest of the floor traps are connected. 

  

 

Floor Plan 

 

 

3D Model 
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3. Modelling Overall Floor Layout 

To complete the layout for the whole floors and building, modelers should familiarize 

themselves to the following commands in Revit. 

 

 

Group 
This is to group all the different elements comprising 1 typical unit to 
allow reuse or repetition. 

 

Mirror 
To create an adjacent copy of the unit. 

 

Grouping Typical Unit Layout: 

 Select the all the elements that belongs to the unit. 

 From the Modify, click the Group.  

 

Copying MEP Layout to Adjacent Unit   

a. Select the grouped unit and Click the Mirror tool from the modify tab. 

b. Pick the Mirror Axis. Elements will then be mirrored and placed in an adjacent unit. 

 

Modelling and Placing Layout into the Different Floors: 

a. Select the Group that you want to copy and place into a different floors. 

 

b. From the clipboard panel, select Copy to Clipboard.  

 

c. Then click the Paste, from the list, click Paste to Selected Level and tick the level you 

intended to place the grouped unit. 

 

Modelling Tips:  

The more model Group you copy and paste, the more times it will generate. 

 

Once done, the model will be like the figures below. 
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The MEP Model is ready for documentation. 

 

 

4. Documentation 

This is the last step of the Detailed Stage where the model will be prepared for regulatory 

submission and tendering. 

 

Objectives:  

To extend the information of the model by putting additional properties such as 2D details 

and attributes. 

 

Deliverables: 

 Model for Tendering 

 Model for BIM e-Submission 
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Step 1: Prepare BIM model for Tendering and e-Submission 

 

The floor plans, sections and other drawings required for tendering can be generated 

directly from the BIM model. Reference should be made to the MEP BIM e-submission 

Guidelines in preparing drawings for regulatory approvals. 

 

The steps below can be applied to both Mechanical and Plumbing trades of the project.  

 

Preparing Typical Floor Plans 

Open the typical floors of the created model. Zoom-in to one of the typical units and do the 

following steps: 

 

a. From view tab, select Callout. Right click to the selected Callout and Open the View 

 

b. From the Annotate tab, click Tag by Category and select the elements in the model. 

 

Standard annotation/tags available in the software can be used to annotate the model. If 

required load other annotation and customise them. Refer to Revit help for family 

creation. 
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c. Complete the annotation in the model by using Text tool and other detailing tool if 

necessary. See the figures below. 

 
 

Placing Drawings into Sheets 

a. Once the drawing views (plans, schematics etc) are clearly annotated, they can be 

organized and placed in sheets with the steps below:.  

 

b. Create a sheet for the intended tender drawing. HDB has standards title block loaded into 

the template. Select the appropriate one. 

 

c. From the project browser, drag and drop the drawing to be placed. 

 

d. Once done, the drawing will be the same as the figures on the next page. 
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Repeat the same procedures to produce the documents listed below: 

 Content of Contract Drawing 

 Layout and Key Plans 

 Site Plans 

 Floor Plans 

 

Publishing Model and Drawings to Non-editable File Format 

Refer to Appendix C of Architectural BIM e-Submission Guideline for step-by-step guide to 

export/ publish to DWF for regulatory submission. 

 

Note: 

The drawings produced from the BIM model during the Detailed Design stage can form part 

of the tender documents together with other 2D detail drawing. 
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